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| 3. PRODUCT INTRODUCTION I

Digital panel meters by Electro-Numerics, Inc. are versatile, cost effective solutions to a wide
variety of monitoring and control applications. Depending on the choice of signal conditioner,
they are easily set up for an accurate display of temperature, pressure, flow, weight, voltage or
current, all in appropriate engineering units and with zero and span adjustment when needed.
Setup can be via front panel pushbuttons or the meter’'s serial interface. Selective security
lockout of the front panel keys protects against accidental changes to meter setup.

High read rates up to 60 per second (50 for 50 Hz operation) are made possible by
Concurrent Slope Conversion (Pat 5,262,780), which integrates the signal over an AC power
line cycle for maximum noise rejection. High read rates provide accurate peak and valley
capture, and quick response for control applications. An adaptive digital filter supplies a time
constant for the encountered signal noise level, yet responds rapidly to changes that exceed a
selected threshold. Self-calibration occurs automatically after every 17th reading.

The standard power supply is a high-efficiency switching unit that operates from AC or DC,
and allows the meters to be powered from worldwide AC without changes. A low-voltage
supply is optional for power from 10-48V batteries or from 12-30 Vac. Both supplies provide an
isolated 5, 10 or 24Vdc transducer excitation output.

The meter case conforms to the 1/8 DIN size standard. It is made of high impact, 94V-0 UL-
rated plastic and is watertight to NEMA-4 (IP65) when panel mounted. Mounting is from the
front of the panel and requires less than 110 mm behind the panel. Power and signal wiring is
via removable plugs conforming to UL61010C safety standards. All output options are isolated
from meter and power ground to 250 Vac.

Extended meter versions can linearize nonlinear inputs. Up to 180 data points may be
linearized by a computer program that stores setup parameters in nonvolatile memory.
Extended meters can also display rate of change, for example to display flow rate based on
changing tank level.

Alarm or setpoint control is provided by an optional relay board with two or four Form C 8A
mechanical relays or two or four Form A 130 mA solid state relays. The setpoints may be
latching or non-latching, be energized above or below the setpoint, or operate in a fail-safe
mode. The relays can operate from the filtered signal to reduce relay chatter or from the
unfiltered signal for fastest response. Snubber circuits and a programmable relay switching
time delay extend relay contact life.

An isolated analog output  of 4-20 mA, 0-20 mA, 0-10V or -10 to +10V can be provided by an
optional analog output board. The output is linearized to the display and can operate from the
filtered or unfiltered signal input. It can be scaled via front panel pushbuttons or the meter’s
serial interface.

Ethernet USB, RS232, or RS485 (2-wire half-duplex or 4-wire full-duplex) serial communi-
cations options are available with the Modbus protocol or a simpler custom ASCII protocol.
Modbus operation includes RTU or ASCIlI modes, up to 247 digital addresses, and up to 32
devices per RS485 line without a repeater. Ethernet-to-RS485 and USB-t0-RS485 converter
boards allow a meter to be interfaced to a PC and to multiple meters on an RS485 network.

Meter programming can be via the meter’s front panel or a PC running Windows based
Instrument Setup Software (serial interface option required).
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| 4. RECEIVING & UNPACKING I

Your meter was carefully tested and inspected prior to shipment. Should the meter be
damaged in shipment, notify the freight carrier immediately. In the event the meter is not
configured as ordered or the unit is inoperable, return it to the place of purchase for repair or
replacement. Please include a detailed description of the problem.

| 5. SAFETY CONSIDERATIONS I

A Warning : Use of this equipment in a manner other than specified may impair the pro-
tection of the device and subject the user to a hazard. Visually inspect the unit for signs of
damage. If the unit is damaged, do not attempt to operate.

Caution:

This unit must be powered with AC (mains) from 85-264 Vac with the high voltage power
supply option, or 12-32 Vac (10-48 Vdc) with the low voltage power supply option. Verify
that the proper power option is installed for the power to be used. This meter has no AC
(mains) switch. It will be in operation as soon as power is connected.

The 85-264 Vac mains connector (P1 Pins 1-3) is colored Green to differentiate it from
other input and output connectors. The 12-32 Vac (10-48 Vdc) mains connector is colored
Black.

Do not make signal wiring changes or connections when power is applied to the instrument.
Make signal connections before power is applied. If reconnection is required, disconnect
the AC (mains) power before such wiring is attempted.

To prevent electrical or fire hazard, do not expose the instrument to excessive moisture.

Do not operate the instrument in the presence of flammable gases or fumes; such an
environment constitutes a definite safety hazard. This meter is designed to be mounted in a
metal panel.

Verify the panel cutout dimensions, and mount according to instructions.

Symbols used

A Caution (refer to accompanying documents) L Earth (ground) terminal.

A Caution, risk of electric shock. “N\_ Both direct and alternating current.

] Equipment protected throughout by double
insulation or reinforced insulation.

Operating environment:

The meter is Class Il (double insulated) equipment designed for use in Pollution degree 2.



6. CONNECTOR WIRING INFORMATION

CONNECTORS

Connectors for signal and power are UL-rated
screw-clamp terminal blocks that plug into
mating jacks on the printed circuit board.
Communication connectors are a single RJ11
plug for RS232, dual RJ11 plugs for RS485,
dual RJ45 plugs for RS485 Modbus, or USB.

P1 - POWER AND DIGITAL CONTROLS

ACHI (+DCHI)
AC NEUTRAL (DC RET)
EARTH GROUND

CONTROL INPUT 2 (+5V OUT)*

ﬁ CONTROL INPUT 1*

DIGITAL GROUND
Warning: Hazardous voltages may be present
on pins 4, 5 & 6 of P1 since digital ground is tied
to pin 3 of P5 (-Signal Input). Keep pin 3 close to
earth ground to minimize common mode voltage
or shock hazard at pins 4, 5 & 6 of P1.

\BEH) |BEE

Ok WKhN =

PS5 - SIGNAL INPUT
DC & PROCESS

-EXCITATION

Signal Source

Note: Control inputs 1 & 2 of P1 are menu
selectable.

LOAD CELLMETER

-10 V EXCITATION
-SENSE

-SIGNAL

+SIGNAL

+10 V EXCITATION
+SENSE

1
2
3
4
5
6

J5

EEEEEE

RTD & OHMS (2-WIRE)

1| B0 [ of ~in

+EXCITATION 2l M0 — — — —*

- SIGNAL INPUT  3[ T * o
+SIGNAL INPUT 41 XX ] +

2WIREPROCESS TRANSMITTER

Signal Source

- EXCITATION 1

+ EXCITATION 2 ——|
- SIGNAL INPUT 3 ‘
+SIGNAL INPUT 4

RTD & OHMS (3-WIRE)

[=1=]1(=1=

-24V EXCITATION 1[m - EXCITATION 1[ I
+24V EXCITATION 2L 1] + + EXCITATION 2L XD}
- SIGNAL INPUT 3] T - - SIGNAL INPUT 3[ T
+SIGNAL INPUT 4| XX} ! +SIGNAL INPUT 41 XX ] ’
STRAINGAUGE RTD & OHMS (4-WIRE)
-1OVEXCITATION [ TEm - EXCITATION 1] @m
+10V EXCITATION 2L [0 + EXCITATION 2L W
-SIGNAL 3[mmH - SIGNAL INPUT 3] o
+SIGNAL 4| XX ] +SIGNAL INPUT 41 ZX
AC (TRUE RMS) THERMOCOUPLE
SIGNAL HIGH 1] mm|—2,20,200, 600V INPUTS 1 mm
NC 20 ] 2L 1|
SIGNALLOW 3[ m|— AC NEUTRAL - SIGNAL INPUT 3" |——,
SIGNAL HIGH 4L XX 0.2V, CURRENT INPUTS +SIGNAL INPUT 4| XX}




P3 - SERIAL COMMUNICATIONS

RS232 INTERFACE

N/C

ISO GND
RX

TX

RTS
N/C

RS485 INTERFACE - FULL DUPLEX

ISO GND
BRX
ARX
ATX
BTX
ISO GND

=

Computer

4 wm

GND

3 -

TX

RX

=

RTS

6-I

GND

5 = I

BTX

4 w——

ATX

3 -

ARX

2 = |

BRX

1 - I

GND

RS485-MODBUS - FULL DUPLEX

(A") RXDO -
(B') RXD1 +

(B) TXD1 *
(A) TXDO -

ISO GND

TXDO

TXD1

RXD1

RXDO

GND

P4 - ANALOG OUTPUT

UNIPOLAR CONNECTIONS
4-20 mA or 0-20 mA OUTPUT
0-10V OUTPUT
ISOLATED GROUND

BIPOLAR CONNECTIONS
REFERENCE or RETURN
-10V to +10V OUTPUT

11
2 [
3 D
1
2| [
It B |

RS485 INTERFACE - HALF DUPLEX

ISO GND

ATX / ARX
BTX/BRX
ISO GND

6 == | B
5 mmm
4 wmm

3 -

a I

1 - I

GND

ATX [ ARX
BTX/BRX
GND

RS485-MODBUS - HALF DUPLEX

(B) TX / RXD1
(A) TX / RXDO

ISO GND

7

1 =
2 =
3 =

4
5 -

6 mmm
7 ==

g mmm

(B) TX/RXD1
(A) TX/RXDO

GND




| 7. MECHANICAL ASSEMBLY I

REMOVING THE REAR PANEL

First remove any connectors. Use one hand to press in the two sides of the rear of the
case, and the other hand to press down the two protruding tab releases at the top of the
rear panel (see figure below). This will unhook the rear panel from the case.

Retaining tab — ¥~—_ Retaining tab

with tab release with tab release

Retaining tab

\ — Retaining tab

Rear Panel
REMOVING THE ELECTRONICS

With the rear panel removed, grasp the power supply board to the left and signal condi-
tioner board to the right, and carefully slide the electronic assembly out through the rear of
the case. (see figure below).

INSTALLING NEW OPTION BOARDS

Options boards plug into the main board at the front of the meter. These are plug-and-play
and may be installed in the field. They will be recognized by the software, which will
provide access to the menu items associated with that board. If necessary, remove rear
panel knockouts for new boards. Boards plug into connectors as follows:

Option Board Main Board Plug Rear Panel Jack
Power supply P11 J1
Relay board P12 J2
Serial interface board P13 J3
Analog output board P14 J4
Signal conditioner board P15 J5




Note: Corresponding main board and option board connectors have the same number of
electrical lines. When an option board is correctly installed, the top and bottom edges of the
main board and option board are aligned.

REASSEMBLING YOUR METER

Slide the electronics assembly into the case until the display board is seated flush against
the front overlay. Insert the bottom tabs of the rear panel into the case, and then carefully
align the board connectors with the openings in the rear panel. If necessary, remove any
rear panel knockouts for new option boards that may have been installed. Ensure that all
option boards are properly aligned with the molded board retaining pins on the inside of the
rear panel. Once the rear panel is in place, reinstall the input/output screw clamp terminal

plugs.
PANEL MOUNTING

Ensure that the panel mounted gasket is in place against the back of the bezel. Turn the two
mounting screws counterclockwise until the space between the mounting pawl and the rear
of the gasket is greater than the panel thickness. Insert the meter in the panel cutout. Turn
the mounting screws clockwise until the meter is securely mounted in the panel. Do not
overtighten.

Dimensioned case drawings



| 8. FRONT PANEL SETUP KEYS I

Meter Front Panel

There are four front panel keys, which change function for the Run Mode and Menu Mode,
effectively becoming eight keys. The keys are labeled with alphanumeric captions (MENU,
PEAK, RESET, ALARMS) for the Run Mode and with symbols ( > right arrow, A up arrow,
< left arrow) for the Menu Mode.

FRONT PANEL LOCKOUT

The Menu Mode will not work with most meters shipped from the factory, since all menu
items have been disabled in software and a lockout jumper is in place. This jumper needs
to be removed for the Menu Mode to work, and values under need to
be set to "0" via the front panel for these menu items to be available. The paragraphs
below assume that all menu items have been unlocked.

MENU MODE KEY ACTION

In the Menu Mode, pressing a key momentarily advances to the next menu item. Holding
down a key automatically advances through multiple menu items for fast menu navigation.

KEYS IN RUN MODE

MENU Key. Pressing MENU from the Run Mode enters the Menu Mode. Pressing
MENU repeatedly will step the meter through the various menu items (if these have not
been locked out) and then back to the Run Mode.

PEAK Key. Pressing PEAK causes the peak value of the input signal to be displayed.
The peak display blinks to differentiate it from the normal present value display.
Pressing PEAK again will return the display to the present value.

RESET Key. Pressing RESET with PEAK resets peak and valley values. Pressing
RESET with ALARMS resets latched alarms. Pressing RESET with MENU performs a
meter (same as power on). Pressing and releasing RESET without pressing another
key, changes the displayed item if the mode has multiple items. For Item 1, the V LED is
out. For Item 2, the V LED is on. For Item 3, the V LED is flashing.

ALARMS Key. Pressing ALARMS once displays the setpoint for Alarm 1. Pressing it
again displays the setpoint for Alarm 2. Pressing it again returns to the present value.
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KEYS IN MENU MODE

Right Arrow Key (MENU). Pressing > steps the meter through all menu items that
have been enabled and then back to the Run Mode. With the DC signal conditioner
board and no option boards, available menu items are [T, S=0E Sz IEKI.

(=N, NS, OfER, I, ], K] If a change has been made to a menu

item, that change is saved to non-volatile memory when the > key is pressed next, and
is displayed briefly.

Right Arrow Key (Digit Select).

Pressing > from the InPut menu brings up all meter functions available with the
meter's signal conditioner. For the DC signal conditioner, these are |JEIejU],

ENtell rAtio |}

Pressing > from the SEtuP, ConfFG, FiLtr, SCALE, OFFSt, Loc 1, Loc 2 or Loc 3
menus items sequentially selects digit positions 1 - 5, as indicated by a flashing digit:

Pressing > from the dEC.Pt menu item sequentially selects decimal point positions,

which will flash: dddad]

Up Arrow Key (Value Select). Pressing A for a flashing item (digit position or decimal
point position) will increment that item. Pressing MENU will save any changes.

Left Arrow Key (Reverse Menu).  Pressing < has the same effect as the MENU key,
except that menu items are brought up in reverse order.
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| 9. ENABLING & LOCKING OUT MENU ITEMS I

For security reasons and ease of meter operation, any and all
menu items may be disabled or "locked out" so that they are no
longer directly accessible from the front panel. Each function to
be disabled is set to "1" in menu items Loc 1, Loc 2 or Loc 3, and
each function to be enabled is set to "0." The top menu items
Loc 1, Loc 2 and Loc 3 can in turn be locked out by installing an
internal hardware jumper. With the jumper installed, the operator
only has access only to enabled menu items. With the jumper
removed, the operator also has access to menu items Loc 1, Loc
2 and Loc 3.

SETTING HARDWARE LOCKOUT JUMPER

To access the lockout jumper, remove the rear panel per Section
9 and locate jumper “a” in the lower portion of the power supply
board next to the input connectors (see figure at right).

SETTING SOFTWARE LOCKOUTS .
Enabled or Disabled

When setting up the meter, it may be necessary to [ Menu ltems
enable specific menu items by setting the corres-
ponding lockout digit to 0. Be sure to reset the lockout | [KeJeg!

digit to "1" if you do not want the menu item to be | 1 - Input type selection.

changed by an operator. 2 - Meter setup, configuration
& decimal pt.
Loc 1 3 - Filter selection.

Press the > MENU key until Loc 1, Loc 2 or Loc 3is | 4 - Scale or Lo, Hiinput.
displayed, as desired. Note: the hardware lockout | 5 - Offsetor Lo, Hi reading
jumper must be removed (see above). Loc 2

2 - Alarm setup.

11111 :
> ) - 3 - Alarm setpoint value
Press > to display the lockout status, consisting of programming.

1's and 0’s. The left digit will flash. Press > againto | , _ Analog output scaling.

step to the next digit, which will flash. 5 - Serial interface setup.
00000 Loc 3
12345 2 - View peak value

Press > to set the flashing digit to "0" to enable the | 3 - View alarm setpoints

menu item or to "1" to disable. Press MENU to enter. | 4 - Reset (peak & latched alarms)
See the table to the right for list of menu items that | 5 - Reset(meter reset)

can be enabled or disabled.
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| 10. READING COORDINATES OF 2 POINTS SCALING METHOD I

When the reading coordinates of 2 points scaling method has been selected under SIS,
the four menu items below will appear ahead of all other menu items when the MENU or
> key is first pressed from the run mode.

This scaling method applies a straight line fit between two points, which are determined
from actual transducer signals and the desired corresponding meter readings. A low signal,
such as the output of a pressure transducer at zero pressure, and high signal, such as the
output of the same transducer at a known high pressure, are applied to the meter. The
desired corresponding low and high readings are then entered from the front panel. The
meter then applies straight line fit between the high and low calibration points. This scaling
method has the advantage of calibrating the transducer and meter as a system. The actual
voltage or current at either point does not need to be known. This method is ideal for
process and load cell meters, which require zero and span adjustment. It is also available
for DC or AC meters. It is not available with thermocouple or RTD meters.

The programming example below is for a process meter used with a 4-20 mA pressure
transducer for 0 to 100 psi. Decimal points are set separately using the dEC.Pt menu.

Press Menu Select Press Digit Select Press Value Select
Key Key Key

Apply low signal input | JEEXJEH Press > to display | JEJEEl Press A to store low
(e.g., transducer output for 0 | reading at low signal input | reading.
psi). (e.g., 4.021 mA).

Apply high signal input _ PKEY! Press A to store high
(e.g., transducer output for | USRI Press > to display | reading.

known 100.00 psi source). reading at high signal input
(e.g., 20.094 mA).

BRI Select [ thru § for
Mode to enter desired low Select digit | flashing first digit, {§ thru § for
reading (e.g., 0.00). to flash. other flashing digits.

Hi rd Select B thru § for
Mode to enter desired high Select digit | flashing first digit, [§ thru § for
reading (e.g., 100.00). to flash. other flashing digits.

13



11. DC VOLTS, AMPS, PROCESS, STRAIN INPUT

The DC Volts, Amps, Process and Strain meters utilize the DC signal conditioner board, which
needs to be configured via jumpers for the desired voltage or current range. All signal ranges
are factory calibrated with calibration factors stored in EEPROM. The meter software
recognizes the board and will bring up the appropriate menu items for it; however, it does not
recognize the jumper settings. Please see further manual sections for setup of the following:
relay output (16), analog output (17), communications (18), and transducer excitation output
(29).

Voltage Ranges Jumpers
FS Input E1l E2 E3
+200.00 mV A f b
+2.0000 V A f a
+20.000 V B h b
+200.00 V B h a
+300V (UL) B g a
+600V (not UL) B g a
Current Ranges Jumpers
FS Input E1l E2 E3
+2.0000 mA A e, g b
+20.000 mA A d, g b
+200.00 mA A C, g b
+5.000 A A a,b,g b
1. Letters indicate jumper position. Jumpers are i nstalled on pins adjacent to letters.
2. Use 5 mm (0.2") jumpers for locations designated by a capital letter.
3. Use 2.5 mm (0.1") jumpers for locations designated by a lower case letter.
4. Store spare jumpers on an unused jumper post not associated a capital letter.

SCALE & OFFSET SETUP

For DC voltmeters & ammeters , a scale factor of 1 and an offset of O are used for direct
readings in (milli)volts or (milli)amperes. Decimal point selection does not affect the displayed
digits. For example, 0-20V or 0-20 mA signals can both be displayed as 0-20000. A full scale
of 20000 may be displayed as 20.000 mA or 20000 pA. Use with a current shunt will require a
scale factor to be set. For example, for a 500-100 (500A, 100 mV) shunt, divide 5000 (the
desired full scale display with 0.1A resolution) by 10000 (displayed value with 100 mV when
the scale factor is 1.0) for a scale factor of 0.5.

For process & strain meters, scaling is normally set up from the front panel using the > and
A keys, but can also be set up via RS232/485 using special PC-compatible setup software
(available at no charge). The meter allows three scaling methods to be selected: 1) Scale and
offset, 2) Coordinates of 2 points, and 3) Reading coordinates of 2 points. Only menu items
applicable to the selected method will be presented.

14



KEYSTROKES FOR SETUP
If the MENU key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

Press Menu Press Digit Press Value Select
Select Key Select Key Key
dCc U 20.0Ul200.0Ul600.0U
Selection of signal | DC Volts 0.2, 2, 20, 200, 660V FS
nput ype & range 200.0:
DC Amps 0.2, 20, 200 mA, 5A FS
2000
Strain gauge & ratio 0.2, 2, 20V FS.
SEtuP 00 00 @ 4-1/2 digits (+20,000)
Meter Setup Display selection with Remote display (+99,999)
scale factor of 1. 2 4-1/2 digits, counts by 10 (£20,000)
3-1/2 digits (+2,000)
00 00 @ Noise minimized for 60 Hz
Power line frequency Noise minimized for 50 Hz
00_ 00 @ Scale and offset method
Scaling method Coordinates of 2 points method
Reading coordinates of 2 points method
00_00 [ 1=Reset, 2 = Meter Hold
Control inputs 1 & 2: 1 = Function Reset, 2 = Peak or Valley
True = logic 1 (OV or 1 = Hold, 2 = Peak or Valley Display
tied to digital ground) | & 1=Hold, 2 =Tare
False = logic 0 (5V or i f ?Z?ek gr—vl?elcla?é tDlsplay, 2 =Tare
open - 1 e
pen) B 1=1,2=1, decimal point = XXXXX
1=0, 2=1, decimal point = XXXX X
1=1, 2 =0, decimal point = XXX XX
1=0, 2 =0, decimal point = XX XXX
1=1, 2 =1, decimal point = XXXX X
1=0, 2 =1, decimal point = XXX XX
1=1, 2 =0, decimal point = XX XXX
1=0, 2 =0, decimal point = X XXX.X
B 1 = Function Reset, 2 = Display Blank
[ 1=Hold, 2 = Display Blank
A 1 = Peak or Valley, 2 = Display Blank
[} 1 =Tare, 2 = Display Blank

1 = Valley Display, 2 = Peak Display

[ 1=Tare, 2 = Reset Tare to Zero

Both inputs 1 and 2 set to logic 1 for selec-
tions @, B, B, @ = Function Reset

Both inputs 1 and 2 set to logic 1 for selec-

15



Press Menu Press Digit Press Value Select
Select Key Select Key Key
000 0 Bl Not rate of change
Meter Configuration | Operation as a rate of Rate x 0.1
change meter. Rate x 1
Extended meter only. Rate x 10
Rate x 100
Rate x 1000
B Rate x 10000
(0 O [l Peak Display. Also selects “Peak” in
Operation of front “Peak or Valley” at connector above.
panel PEAK button Valley Display. Also selects “Valley” in
and rear connector for “Peak or Valley” at connector above.
Peak or Valley Display Peak (1st push), Valley (2nd push)
Front panel Tare
000 O @ Meter comes up in normal run mode.
Auto-tare Meter comes up in auto-tare mode
000 O @ Linearinput
Nonlinear input scaling Custom curve linearization

Extended meter only.

00000 B Unfiltered output
Filtering Alarm filtering Filtered output
00000 § Unfiltered Peak & Valley
Peak & Valley filtering Filtered Peak & Valley
00000 @ Display batch average every 16 readings
Display filtering Display filtered signal
oleojoJo]le Adaptive filter @ Low adaptive filter threshold level
threshold High adaptive filter threshold level
00000 B Autofilter
Input signal filtering. Batch average, 16 readings
Can be applied to dis- Moving average, 0.08 sec.
play, setpoint, analog Moving average, 0.15 sec.
output, data output. Moving average, 0.3 sec.
Moving average, 0.6 sec.
B Moving average, 1.2 sec.
Moving average, 2.4 sec.
B Moving average, 4.8 sec.
 Moving average, 9.6 sec.
B unfiltered
d_dddd d_ddddfidd_dddiddd_ddfldddd_dffddddd

Dec. point selection

Decimal point flashes.

elelslsls] Press A to shift the decimal point.
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Press Menu
Select Key

Press Digit
Select Key

Press Value Select
Key

Scaling method “Scale and Offset” if selected under

SCALE
Scale factor

.0000
.0000

0.0000

ii

Select ¥ thru ] for flashing first digit, [§] thru §
for other flashing digits. Select decimal point
location when decimal point is flashing.

Select digit to flash.
0.0000§0.0000[§0.0000
Offset value 0.00000.0000

wn

elect digit to flash.

Select B thru ] for flashing first digit, § thru §
for other flashing digits. Decimal point
location is selected by [s|={efx1.

Scaling method “Coordinates of 2 points” if sel

ected under SRS

ONONNN SN SNeNNN | Select K thru § for flashing first digit, § thru §
Low signal input. 0.0000[§0.0000 for other flashing digits. Decimal point is set
Select digit to flash. by input range chosen.

ONONNN SN SNeNNN | Select B thru § for flashing first digit, § thru §
Desired reading at | A o[efold SHelel) for other flashing digits. Decimal point is set

Lo In. Select digit to flash. RYdEC Pt

Hi In PXLLLe] CNONKle SNellels | Select [ thru g for flashing first digit, § thru g

High signal input. 0.0000§§0.0000 for other flashing digits. Decimal point is set
Select digit to flash. by input range chosen.

ONONNN SN SNeNNIY | Select K thru § for flashing first digit, § thru §

Desired reading at | A o[efold SNelel) for other flashing digits. Decimal point is set

Hi In. by S[EeN=.

Select digit to flash.

Scaling method “Reading coordinates of 2 points” if selected under

0.02
Apply a low reference
signal to the meter.

oln
Low signal input.

I
!

Press A to store the low signal input in the
meter.

5

N
o
o
©

4
Apply a high reference
signal to the meter.

ad T

igh signal input.

Press A to store the high signal input in the
meter.

0.0000§0.0000[§0.0000f§0.0000

Desired reading at | Kool SNOIIY Select [ thru §] for flashing first digit, § thru

Lo In. Select diqit to flash. for other flashing digits. Decimal point is set
J AJEC. Pt}

0.0000§0.0000[§0.0000f)6.7500

Desired reading at | Kol SNONY Select [ thru g for flashing first digit, § thru

Hi In. for other flashing digits. Decimal point is set

Select digit to flash.

by

1
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Option board dependent menu items

Menu items related to alarm setup These will only appear if a relay board is detected. If so,
please see Sectionl6.

Menu items related to analog output setup . These will only appear if an analog output
board is detected. If so, see Section 17.

Menu items related to serial communications . These will only appear if an RS232 or
RS485 1/0O board is detected. If so, see Section 18.

Menu lockout items

Menu items used to enable or lock out (hide) other menu items. Loc menu items may in turn
be locked out by a hardware jumper. Please see Section 9.

* Scaling method 2, “Reading Coordinates of 2 Points Scaling Method,” will appear before all
other Menu items, including JJII&¥. Decimal point is set by =S¢zl
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| 12. LOAD CELL & MICROVOLT INPUT I

The Load Cell and Microvolt meters utilize the load cell signal conditioner board, which offers
sensitivity to £20 mV full scale and 4 or 6-wire load cell connection. This board needs to be
configured via jumpers for the desired voltage range. All signal ranges are factory calibrated
with calibration factors stored in EEPROM. The meter software recognizes the board and will
bring up the appropriate menu items for it; however, it does not recognize the jumper settings.
Please see further manual sections for setup of the following features: relay output (16),
analog output (17), communications (18), and transducer excitation output (19).

RANGE SELECTION VIA JUMPERS

Ranges & Display with
Scale Factor =1

Input Jumpers F_uII scale
display

+20 mV e +20000

+50 mV a +50000

+100 mV b +10000

+250 mV c +25000

+500 mV d +50000

Notes 1. See Section 19 to select 10V excitation.
2. Jumpers are 2.5 mm (0.1 in).

SCALE & OFFSET SETUP

For DC microvolt meters , a scale factor of 1 and an offset of O are used for direct readings in
microvolts or millivolts. Decimal point selection does not affect the displayed digits. For
example, 20 mV can be displayed as 20.000 mV or 20000 pV. The decimal point is set
separately.

For load cell applications, scaling is normally set up from the front panel using the P and A
keys, but can also be set up via RS232/485 using special PC-compatible setup software
(available at no charge). The meter allows three scaling methods to be selected: 1). Manual
scale and offset, 2) Coordinates of 2 points, and 3) Reading coordinates of 2 points. Please
see the Glossary for an explanation of each method.
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KEYSTROKES FOR SETUP
If the MENU key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

Press Menu Press Digit Press Value Select
Select Key Select Key Key
Selection of signal | Strain or ratiometric 20, 50, 100, 250, 500 mV FS voltage
nputtype & range
DC millivolts 20, 50, 100, 250, 500 mV FS voltage
SEtuP 00_00 @ 4-1/2 digit meter, counts by 1
Meter Setup Display type 5-digit remote display (x99,999)
4-1/2 digit meter, counts by 10
3-1/2 digit meter
00 00 @ Noise minimized for 60 Hz
Power line frequency Noise minimized for 50 Hz
00 00 @ Scale and offset method
Scaling method Coordinates of 2 points method
Reading coordinates of 2 points method
00_00 [ 1 =Reset, 2 = Meter Hold
Rear connector control 1 = Function Reset 2 = Pk or Valley Disp.
inputs 1 & 2. 1 = Meter Hold 2 = Pk or Valley Disp.
True = logic 1 (OV or 1 = Meter Hold 2 =Tare
tied to digital ground) 1 =Peakor Valley 2=Tare
False = logic 0 (5V or 1= Tare _ 2=Reset
open) B 1=0,2=0, decimal point 1= XXXXX
1=1, 2=0, decimal point 1 = XXXX X
1=0, 2 =1, decimal point 1 = XXX XX
1=1,2=1, decimal point 1 = XX XXX
1=0, 2 =0, decimal point 2 = XXXX X
1=1, 2=0, decimal point 2 = XXX XX
1=0, 2 =1, decimal point 2 = XX XXX
1=1,2=1, decimal point 2 = X XXX.X
B 1 = Function Reset 2 = Display Blank
& 1=Hold 2 = Display Blank
A 1 = Peak or Valley 2 = Display Blank
B 1=Tare 2 = Display Blank
1 = Valley Display 2 = Peak Display
B 1=Tare 2 = Tare Reset

Both control inputs 1 & 2 set to 1 for selec-
tions &, @, I, [® = Function Reset.
Both control inputs 1 & 2 set to 1 for selec-
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Press Menu Press Digit Press Value Select
Select Key Select Key Key
000 0 Bl Not rate of change
Meter Configuration | Operation as a rate of Rate x 0.1
change meter. Rate x 1
Extended meter only. Rate x 10
Rate x 100
Rate x 1000
B Rate x 10000
000 0 [l Peak Display. Also selects “Peak” in
Operation of front “Peak or Valley” at connector above.
panel PEAK button Valley Display. Also selects “Valley” in
and rear connector for “Peak or Valley” at connector above.
Peak or Valley Display Peak (1st push), Valley (2nd push)
Front panel Tare
B Meter comes up in normal run mode.
Auto-tare Meter comes up in auto-tare mode
000 O @ Linearinput
Nonlinear input scaling Custom curve linearization

Extended meter only.

00000 B Unfiltered output
Filtering Alarm filtering Filtered output
00000 § Unfiltered Peak & Valley
Peak & Valley filtering Filtered Peak & Valley
00000 @ Display batch average every 16 readings
Display filtering Display filtered signal
ofejoJo]s Adaptive filter @ Low adaptive filter threshold level*
threshold High adaptive filter threshold level
00000 B Autofilter
Input signal filtering. Batch average, 16 readings
Can be applied to dis- Moving average, 0.08 sec.
play, setpoint, analog Moving average, 0.15 sec.
output, data output. Moving average, 0.3 sec.
Moving average, 0.6 sec.
B Moving average, 1.2 sec.
Moving average, 2.4 sec.
B Moving average, 4.8 sec.
 Moving average, 9.6 sec.
B unfiltered
d_dddd d_ddddfidd_dddlddd_ddfldddd_df§ddddd

Dec. point selection

Decimal point flashes.
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Press Menu
Select Key

Press Digit
Select Key

Press Value Select
Key

Scaling method “Scale and Offset” if selected under

SCALE
Scale factor

.0000
.0000

0.0000

ii

Select ¥ thru ] for flashing first digit, [§] thru §
for other flashing digits. Select decimal point
location when decimal point is flashing.

Select digit to flash.
0.0000§0.0000[§0.0000
Offset value 0.00000.0000

wn

elect digit to flash.

Select B thru ] for flashing first digit, § thru §
for other flashing digits. Decimal point
location is selected by [s|={efx1.

Scaling method “Coordinates of 2 points” if sel

ected under SRS

ONONNN SN SNeNNN | Select K thru § for flashing first digit, § thru §
Low signal input. 0.0000[§0.0000 for other flashing digits. Decimal point is set
Select digit to flash. by input range chosen.

ONONNN SN SNeNNN | Select B thru § for flashing first digit, § thru §
Desired reading at | A o[efold SHelel) for other flashing digits. Decimal point is set

Lo In. Select digit to flash. RYdEC Pt

Hi In PXLLLe] CNONKle SNellels | Select [ thru g for flashing first digit, § thru g

High signal input. 0.0000§§0.0000 for other flashing digits. Decimal point is set
Select digit to flash. by input range chosen.

ONONNN SN SNeNNIY | Select K thru § for flashing first digit, § thru §

Desired reading at | A o[efold SNelel) for other flashing digits. Decimal point is set

Hi In. by S[EeN=.

Select digit to flash.

Scaling method “Reading coordinates of 2 points” if selected under

0.02
Apply a low reference
signal to the meter.

oln
Low signal input.

I
!

Press A to store the low signal input in the
meter.

5

N
o
o
©

4
Apply a high reference
signal to the meter.

ad T

igh signal input.

Press A to store the high signal input in the
meter.

0.0000§0.0000[§0.0000f§0.0000

Desired reading at | Kool SNOIIY Select [ thru §] for flashing first digit, § thru

Lo In. Select diqit to flash. for other flashing digits. Decimal point is set
J AJEC. Pt}

0.0000§0.0000[§0.0000f)6.7500

Desired reading at | Kol SNONY Select [ thru g for flashing first digit, § thru

Hi In. for other flashing digits. Decimal point is set

Select digit to flash.

by

2

2




Option board dependent menu items

Menu items related to alarm setup These will only appear if a relay board is detected. If so,
please see Sectionl6.

Menu items related to analog output setup . These will only appear if an analog output
board is detected. If so, see Section 17.

Menu items related to serial communications . These will only appear if an RS232 or
RS485 1/0O board is detected. If so, see Section 18.

Menu lockout items

Menu items used to enable or lock out (hide) other menu items. Loc menu items may in turn
be locked out by a hardware jumper. Please see Section 9.
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| 13. AC TRUE RMS VOLTS & AMPS INPUT I

AC voltage or current measurement utilizes the True

RMS signal conditioner board which uses precision

circuitry to compute the root-mean-square of complex

waveforms from 10 Hz to 10 kHz. Accurate measure-

ments are obtained with spikes up to 3 times the

maximum of each range. The input can be AC

coupled to read only the AC component, such as

ripple on a power supply, or DC coupled to read AC

plus DC. The board needs to be configured via

jumpers for the desired voltage or current range, and

for AC or DC coupling. All signal ranges are factory

calibrated with calibration factors stored in EEPROM.

The meter software recognizes the board and will bring up the appropriate menu items for it;
however, it does not recognize the jumper settings. These need to be set manually. Please
see further manual sections for setup of the following features: relay output (16), analog output
(17), and communications (18).

Voltage Ranges

Full Scale Input | Counts | Jumpers

200 mV 20000 J
2V 20000 c,g,h
20V 20000 C,Ii
200V 20000 c, k
300V (UL) 3000 c,m
600V (not UL) 6000 c,m

Current Ranges

Full Scale Input | Counts | Jumpers

2 mA 20000 I, k
20 mA 20000 b, m
200 mA 20000 a,m
5A 5000 c,d,e,m
AC or DC Coupling RANGE SELECTION VIA JUMPERS
Coupling Type JUMPErs | 1 | etters indicate jumper position. Jumpers
DC coupling for AC + DC f are installed on pins adjacent to letters.
AC coupling for AC only none 2. Use 2.5 mm (0.1%) jumpers.
3. Store spare jumpers on unused jumper post.

METER SCALING

Refer to the above tables for the full scale counts (or displayed digits) produced by the
available full scale input ranges with a scale factor of 1 and an offset of 0. The decimal point
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can be set for direct readout in (milli)volts or (milli)amperes. Decimal point selection does not
affect the counts. For example, a 20V input may be displayed as 20.000V or 20000 mV.

The 5A range, designed for use with a 5A current transformer (CT), is scaled to produce 5000
counts with a scale factor of 1 and an offset of 0. Use with a specific CT will require the scale
factor to be set. For example, for an 800A input, 5A output CT, set a scale factor of 1.6. This is
the desired 8000 count display at 5A divided by the default 5000 count display at 5A. Then set
the decimal point to display to 800.0 at 5A.

All scaling methods applicable to DC, process, strain and load cell meters are available with
AC RMS meters.

INTERNAL SHIELD

To reduce noise pickup inside the meter or transmitter, the
RMS board is fitted with a flexible plug-on shield. If necessary,
This shield may be removed for jumper setting, but must be
reinstalled before closing the instrument.

SIGNAL SHIELDING

i Sig High  RMS

Signal Source “‘; Sig Low  Board

Shield around twisted pair
Earth Ground
Shielding for noise reduction

AC RMS measurements are susceptible to signal noise. This is especially true when the instru-
ment has a wide bandwidth. To minimize noise pickup, the input signal wiring should utilize a
shielded twisted pair, and the shield should be connected to signal low at the meter, as
illustrated. If signal low is close to earth ground, such as within 2V, signal low can further be
connected to earth ground at the meter, as illustrated.
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KEYSTROKES FOR SETUP
If the MENU key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

Press Menu Press Digit Press Value Select
Select Key Select Key Key
Selection of signal | Strain or ratiometric 0.2, 2, 20, 200, 660V FS
nputtype & range
DC millivolts 2,20, 200 mA, 5A FS
SEtuP 00 00 @ 4-1/2 digits (+20,000)
Meter Setup Display selection with Remote display (+99,999)
scale factor of 1 2 4-1/2 digits, counts by 10 (£20,000)
3-1/2 digits (+2,000)
00 00 [ Noise minimized for 60 Hz
Power line frequency Noise minimized for 50 Hz
00 00 @ Scale and offset method
Scaling method Coordinates of 2 points method
Reading coordinates of 2 points method
00_00 [ 1 =Reset, 2 = Meter Hold
Rear connector inputs 1 = Function Reset 2 = Pk or Valley Disp.
1&2 1 = Meter Hold 2 = Pk or Valley Disp.
True = logic 1 (OV or 1 = Meter Hold 2 =Tare
tied to digital ground) 1 =Peakor Valley 2=Tare
False = logic O (5V or 1=Tare ~ 2=Reset
open) B 1=0,2=0, decimal point 1= XXXXX
1=1, 2=0, decimal point 1 = XXXX X
1=0, 2 =1, decimal point 1 = XXX XX
1=1,2=1, decimal point 1 = XX XXX
1=0, 2 =0, decimal point 2 = XXXX X
1=1, 2=0, decimal point 2 = XXX XX
1=0, 2 =1, decimal point 2 = XX XXX
1=1,2=1, decimal point 2 = X XXX.X
B 1 = Function Reset 2 = Display Blank
& 1=Hold 2 = Display Blank
A 1 = Peak or Valley 2 = Display Blank
B 1=Tare 2 = Display Blank
1 = Valley Display 2 = Peak Display
B 1=Tare 2 = Tare Reset
Both control inputs 1 & 2 set to 1 for selec-
tions @, B, B, @ = Function Reset.
Both control inputs 1 & 2 set to 1 for selec-
tions{@, ll, B, B, &, B, B, ® = Meter Reset.
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Press Menu Press Digit Press Value Select
Select Key Select Key Key
000_0 Bl Not rate of change
Meter Configuration | Operation as a rate of Rate x 0.1
change meter. Rate x 1
Extended meter only. Rate x 10
Rate x 100
Rate x 1000
B Rate x 10000
00 O [l Peak Display. Also selects “Peak” in
Operation of front “Peak or Valley” at connector above.
panel PEAK button Valley Display. Also selects “Valley” in
and rear connector for “Peak or Valley” at connector above.
Peak or Valley Display Peak (1st push), Valley (2nd push)
Front panel Tare
000 O @ Meter comes up in normal run mode.
Auto-tare Meter comes up in auto-tare mode
000 O @ Linearinput
Nonlinear input scaling Custom curve linearization

Extended meter only.

00000 B Unfiltered output
Filtering Alarm filtering Filtered output
00000 @ Unfiltered Peak & Valley
Peak & Valley filtering Filtered Peak & Valley
00000 @ Display batch average every readings
Display filtering Display filtered signal
BRIy Filtering for AC | Non-adaptive moving average filter
signal High-threshold adaptive moving avg filter
00000 B Autofilter
Input signal filtering. Batch average, 16 readings
Can be applied to dis- Moving average, 0.08 sec.
play, setpoint, analog Moving average, 0.15 sec.
output, data output. Moving average, 0.3 sec.
Moving average, 0.6 sec.
B Moving average, 1.2 sec.
Moving average, 2.4 sec.
B Moving average, 4.8 sec.
 Moving average, 9.6 sec.
B unfiltered
d_dddd d_ddddfidd_dddliddd_ddfldddd dffddddd

Dec. point selection

Decimal point flashes.

d

d
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Press Menu
Select Key

Press Digit
Select Key

Press Value Select
Key

Scaling method “Scale and Offset” if selected under

SCALE
Scale factor

.000
.000

0
0

0.0000

ii

Select ¥ thru ] for flashing first digit, [§] thru §
for other flashing digits. Select decimal point
location when decimal point is flashing.

Select digit to flash.
0.0000§0.0000[§0.0000
Offset value 0.00000.0000

wn

elect digit to flash.

Select [{ thru § for flashing first digit, § thru §
for other flashing digits. Decimal point
location is selected by [s|={efx1.

Scaling method “Coordinates of 2 points” if sel

ected under SRS

ONONNN CNlE SNeNNIY | Select K thru [ for flashing first digit, § thru §
Low signal input. 0.0000[§0.0000 for other flashing digits. Decimal point is set
Select digit to flash. by input range chosen.

ONONNN OGNS SNeNNIY | Select K thru [ for flashing first digit, § thru §
Desired reading at | (o[l SNelel) for other flashing digits. Decimal point is set

Lo In. Select digit to flash. RYdEC Pt

Hi In PXLLle CNONKle Nellele | Select [ thru [§ for flashing first digit, [§] thru g

High signal input. 0.0000§§0.0000 for other flashing digits. Decimal point is set
Select digit to flash. by input range chosen.

ONONNN CNlE SNeNNIY | Select K thru [ for flashing first digit, § thru §

Desired reading at | i o[efald SN[l for other flashing digits. Decimal point is set

Hi In. by S[EeN=.

Select digit to flash.

Scaling method “Reading coordinates of 2 points” if selected under

0.02
Apply a low reference
signal to the meter.

oln
Low signal input.

I
!

Press A to store the low signal input in the
meter.

5

N
o
o
©

4
Apply a high reference
signal to the meter.

ad T

igh signal input.

Press A to store the high signal input in the
meter.

0.0000§0.0000[§0.0000§0.0000

Desired reading at | Kool SNOINY Select [ thru g for flashing first digit, § thru

Lo In. Select diqit to flash. for other flashing digits. Decimal point is set
J AJEC. Pt}

0.0000§0.0000[§0.0000§6.7500

Desired reading at | Kool SNOIINY Select [ thru §] for flashing first digit, § thru g

Hi In. for other flashing digits. Decimal point is set

Select digit to flash.

by

2
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Option board dependent menu items

Menu items related to alarm setup These will only appear if a relay board is detected. If so,
please see Sectionl6.

Menu items related to analog output setup . These will only appear if an analog output
board is detected. If so, see Section 17.

Menu items related to serial communications . These will only appear if an RS232 or
RS485 1/0O board is detected. If so, see Section 18.

Menu lockout items

Menu items used to enable or lock out (hide) other menu items. Loc menu items may in turn
be locked out by a hardware jumper. Please see Section 9.

*  Scaling method 2, “Reading Coordinates of 2 Points Scaling Method,” will appear before all
other Menu items, including [JIiIEI. Decimal point is set by S[=eNz-
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| 14. THERMOCOUPLE INPUT I

The thermocouple signal conditioner board used for temperature measurement can be confi-
gured via jumpers for 7 thermocouple types, each in a single range: J, K, T, E, N, S, R. The
meter software recognizes the board and will bring up the appropriate menu items for it;
however, it does not recognize the jumper settings. Display in T or ¥ and resolution of 1°
0.1°or 0.01°are user programmable. High resolution should only be used for relative readings,
not absolute readings. Although available, 0.01° res olution is not recommended for thermo-
couples. Offset adjustment is available for thermocouples and is normally set to 0000.0. If T is
selected, entering an offset of 0273.2 will change the display to Kelvin. If F is selected,
entering an offset of 0459.7 will change the display to Rankin.

The addition of a relay output board turns the thermocouple meter from a temperature indicator
into an on/off temperature controller. Please see further manual sections for setup of the
following features: relay output (Section 16), analog output (17), and communications (18).

SIGNAL CONDITIONER BOARD SETUP VIA JUMPERS

Type E4 Jumper
J,K,E,N none
T, R, S ]

Open Indication E3 Jumper

Upscale h
Downscale i

Letters indicate jumper position.

Jumpers are installed on pins adjacent to letters.
Use 2.5 mm (0.1") jumpers.

Store spare jumpers on an unused jumper post.

N
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KEYSTROKES FOR SETUP

If the MENU key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

Press Menu Press Digit Press Value Select
Select Key Select Key Key

Type J, For T
Selection of signal | Thermocouple K F Type K, F or T
input type & range Type N, F or T
Type E, For T
Type T, For T
Type S, For T
r Type R, For T

SEtuP
Meter Setup

00 00 @ 0.1 degree resolution
Display selection. Remote display (+99,999)
0.01 degree resolution
1 degree resolution
00 00 @ Noise minimized for 60 Hz
Power line frequency Noise minimized for 50 Hz
00 00 @ Offset only for thermocouple input.
Scaling method
00 00 [ 1=Reset, 2 = Meter Hold
ontrol inputs 1 & 2: 1 = Function Reset, 2 = Peak or Valley
True = logic 1 (OV or 1 = Hold, 2 = Peak or Valley Display
tied to digital ground) 1 =Hold, 2 = Tare
False = logic O (5V or 1 = Peak or Valley Display, 2 = Tare
open) 1 =Tare, 2 = Reset
B 1=0,2=0, decimal point 1= XXXXX
1=1, 2=0, decimal point 1 = XXXX X
1=0, 2 =1, decimal point 1 = XXX XX
1=1,2=1, decimal point 1 = XX XXX
1=0, 2 =0, decimal point 2 = XXXX X
1=1, 2=0, decimal point 2 = XXX XX
1=0, 2 =1, decimal point 2 = XX XXX
1=1,2=1, decimal point 2 = X XXX.X
B 1 = Function Reset 2 = Display Blank
g 1=Hold 2 = Display Blank
P 1 =Peak or Valley 2 = Display Blank
[ 1=Tare 2 = Display Blank

1 = Valley Display 2 = Peak Display
B 1=Tare

2 = Tare Reset

Both control inputs 1 & 2 set to 1 for selec-
tions @, B, B, [@ = Function Reset.
Both control inputs 1 & 2 set to 1 for selec-
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Press Menu Press Digit Press Value Select
Select Key Select Key Key
000 0 @ No used.
Met fi ti . .
eter Configuration 00 O [l Peak Display. Also selects “Peak” in
Operation of front “Peak or Valley” at rear connector.
panel PEAK button Valley Display. Also selects “Valley” in
and rear connector for “Peak or Valley” at rear connector.
Peak or Valley Display Peak (1st push), Valley (2nd push)
Front panel Tare
00000 B Unfiltered output
Filtering Alarm filtering Filtered output
00000 @ Unfiltered Peak & Valley
Peak & Valley filtering Filtered Peak & Valley
00000 @ Display batch average every 16 readings
Display filtering Display filtered signal
olojoJo]le Adaptive filter @ Low adaptive filter threshold level
threshold High adaptive filter threshold level
00000 B Autofilter
Input signal filtering. Batch average, 16 readings
Can be applied to dis- Moving average, 0.08 sec.
play, setpoint, analog Moving average, 0.15 sec.
output, data output. Moving average, 0.3 sec.
Moving average, 0.6 sec.
B Moving average, 1.2 sec.
Moving average, 2.4 sec.
B Moving average, 4.8 sec.
B Moving average, 9.6 sec. B Unfiltered
PXY ONelElele SNeIalle | Select B thru [§ for flashing first digit, § thru g
Offset value 0.0000§§0.0000 for other flashing digits. Use offset for display
Select digit to flash. | In Rankine or Kelvin.

Option board dependent menu items

Menu items related to alarm setup if a relay board is detected. Please see Sectionl6.

Menu items related to analog output if detected. Please see Section 17.

Menu items related to serial communications if detected. Please see Section 18.

Menu lockout items

Menu items used to enable or lock out (hide) menu items. Please see Section 9.
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| 15. RTD & RESISTANCE INPUT I

RTD and resistance measurement can be configured via jumpers for four RTD types (DIN
platinum, ANSI 100 platinum, 120 nickel, 10 copper) or five resistance ranges (from
20.000 to 200.00 k ). All ranges are factory calibrated with calibration factors stored in
EEPROM on the signal conditioner board. The meter software recognizes the board and will
bring up the appropriate menu items for it; however, it does not recognize the jumper settings.
With RTDs, display in T or ¥ and resolution of 1° 0. 1°or 0.01°are user programmable.

Please see further manual sections for setup of the following features: relay output (Section
16), analog output (17), and communications (18).

SIGNAL CONDITIONER BOARD SETUP VIA JUMPERS

RTD Type or Ohms E1 Jumper
Pt100, Ni120 a
Culo, 20 b

200 c
2000 d
20000 e

200 k f
Connection E2 Jumper
2 or 4 wire none

3 wire g

1. Letters indicate jumper position. Jumpers are inst alled on pins adjacent to letters.
2. Store spare jumpers on an unused jumper post.

SCALE & OFFSET SETUP

Scale is normally set to 1.0000. Scale can be used as an RTD correction when actual
resistance is other than nominal, as stated on the RTD calibration sheet. For a Pt100 RTD,
divide 100 by the stated resistance at 0C. For example, for a 99.04 ohm RTD, scale should be
set to 100/ 99.04 = 1.0097.

SIGNAL SHIELDING

Shielding for noise reduction

200 k ranges and above measurements are susceptible to signal noise. To minimize noise
pickup, the input signal wiring should utilize a shielded twisted pair and the shield should be
connected to signal low and earth ground at the meter, as illustrated. Use 2-wire hookup
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RTD & RESISTANCE CONNECTION

With the appropriate jumper settings, RTD
and resistance measurements allow 2, 3 or 4-
wire RTD hookup to the J5 connector, as
illustrated. The meter applies a fixed excita-
tion current.

In 4-wire hookup, lead resistance is not a
factor, since different pairs of wires are used
for excitation and sensing.

In 3-wire hookup, the meter automatically
compensates for lead resistance by measur-
ing the voltage drop in one current-carrying
lead and assuming that the voltage drop in
the other current-carrying lead is the same.

In 2-wire hookup, the meter senses the
voltage drop across the load and both lead
wires. The effect of the lead wires can be
measured and subtracted by shorting out the
load during meter setup. The short should be
as close as possible to the load. Ambient
temperature changes will still cause some
error in the readings -- the higher the lead
resistance, the greater the error.

To eliminate lead wire resistance, follow this procedure:

1. Set the InPut menu item and jumpers for the desired range

2. Set CONnFG to [e]elekmi.
3. Short the two leads at the sensor end.
4

. When the display has settled, push the > key. The meter will then store a value propor-

tional to lead resistance, automatically change COnFG to 8J8fekife}, and then reset. The same
result is obtained by grounding a Control Input that has been selected for Peak or Valley
(SEtuP [o[sl&d, where Y =1, 2,4, A, C).

Remove the short and connect the sensor. The meter now processes the sensor resistance
only.

If the range and associated jumpers are subsequently changed, the above procedure must be
repeated. This procedure is also available through Instrument Setup software, Revision 2.7.0
or later.
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KEYSTROKES FOR SETUP

If the MENU key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

Press Menu Press Digit Press Value Select
Select Key Select Key Key
Pt100 RTD, DIN alpha .00385, ¥
Selection of signal | RTD Pt100 RTD, DIN alpha .00385, T
Input type & range PtL00 RTD, ANSI alpha .003902, F
Pt100 RTD, ANSI alpha .003902, T
Ni120 RTD, alpha .00672, ¥
Ni120 RTD, alpha .00672, T
Cul0 RTD, alpha .00427, ¥
Cul0 RTD, alpha .00427, T
0 to 20 ohms
Ohmmeter 0 to 200 ohms
0 to 2000 ohms
0 to 20000 ohms
0 to 200.00 kohm
SEtuP B 0.1°RTD or 4-1/2 digits for ohms
Meter Setup Display selection with 5-digit remote display (x99,999)
scale factor of 1. 0.01°RTD, 4-1/2 digit ohms count by 10
1°RTD or 3-1/2 digits for ohms
00 00 @ Noise minimized for 60 Hz
Power line frequency Noise minimized for 50 Hz
[ Scale and offset method (RTD & ohms)
Scaling method Coordinates of 2 points (ohms)
Reading coordinates of 2 points (ohms)
00 00 [ 1 =Reset, 2 = Meter Hold
Control inputs 1 & 2: 1 = Function Reset, 2 = Peak or Valley
True = logic 1 (OV or 1 = Hold, 2 = Peak or Valley Display
tied to digital ground) 1 =Hold, 2 = Tare
False = logic O (5V or 1 = Peak or Valley Display, 2 = Tare
open) 1=Tare, 2 = Reset
B 1=0,2=0, decimal point 1= XXXXX
1=1, 2=0, decimal point 1 = XXXX X
1=0, 2 =1, decimal point 1 = XXX XX
1=1,2=1, decimal point 1 = XX XXX
1=0, 2 =0, decimal point 2 = XXXX X
1=1, 2=0, decimal point 2 = XXX XX
1=0, 2 =1, decimal point 2 = XX XXX
1=1,2=1, decimal point 2 = X XXX.X
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Press Menu Press Digit Press Value Select
Select Key Select Key Key
SEtuP 00 00 B 1 = Function Reset 2 = Display Blank
Meter Setup Control inputs 1 & 2 ® 1=Hold 2 = Display Blank
(continued) (continued) A 1 =Peak or Valley 2 = Display Blank
[ 1=Tare 2 = Display Blank
1 = Valley Display 2 = Peak Display
B 1=Tare 2 = Tare Reset
Both control inputs 1 & 2 set to 1 for selec-
tions &, 8, I, [® = Function Reset.
Both control inputs 1 & 2 set to 1 for selec-
tions [, , &, B, & &, B, B = Meter Reset.
Operation as a | § Not rate of change E§ Rate x 10

Meter Configuration

rate of change meter.
Extended meter only.

Rate x 1000
B Rate x 10000

Rate x 0.1
Rate x 1

00000

Operation of front
panel PEAK button
and rear connector for

1O RN [

Peak Display. Also selects “Peak” in
“Peak or Valley” at connector above.
Valley Display. Also selects “Valley” in
“Peak or Valley” at connector above.

=

Peak or Valley Display Peak (1st push), Valley (2nd push)
Front panel Tare
00000 @ No auto-tare
Auto-tare selection Auto-tare
00000 RTD Ohms
RTD or Ohms wiring Bl§ 3 or 4 wire 3 or 4 wire
Not allowed Custom curve
2-wire read 2-wire read
2-wire short 2-wire short
00000 B Unfiltered output
Filtering Alarm filtering Filtered output
00000 § Unfiltered Peak & Valley
Peak & Valley filtering Filtered Peak & Valley
00000 @ Display batch average every 16 readings
Display filtering Display filtered signal
oleojoJo]le Adaptive filter @ Low adaptive filter threshold level
threshold High adaptive filter threshold level
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Press Menu Press Digit Press Value Select
Select Key Select Key Key
00000 B Autofilter
Filtering Input signal filtering. Batch average, 16 readings
(continued) Can be applied to dis- Moving average, 0.08 sec.
play, setpoint, analog Moving average, 0.15 sec.
output, data output. Moving average, 0.3 sec.
Moving average, 0.6 sec.
B Moving average, 1.2 sec.
Moving average, 2.4 sec.
B Moving average, 4.8 sec.
B Moving average, 9.6 sec.
A unfiltered
d_dddd d_ddddfldd dddffddd ddffdddd dfiddddd
Decimal point Decimal point flashes
) ddddd
selection if ohms are selected ddddd
under
SCALE PXLl) ONelElele SNeJalsle | Select B thru [§ for flashing first digit, § thru g
Scale factor Xelolels [oMolloe loMeloeye | for other flashing digits. Select decimal point
d|g|t 0 flash- location when decimal point is flashing.
PXY ONeElele NeIalle | Select B thru [§ for flashing first digit, § thru g
Offset value 0.0000§0.0000 for other flashing digits. Use offset for display
Select diait to flash. in Rankine or Kelvin. Decimal point location
J is selected by [s|=(OAX].

Option board dependent menu items

Menu items related to alarm setup These will only appear if a relay board is detected. If so,
please see Sectionl6.

Menu items related to analog output setup . These will only appear if an analog output
board is detected. If so, see Section 17.

Menu items related to serial communications . These will only appear if an RS232 or
RS485 1/0O board is detected. If so, see Section 18.

Menu lockout items

Menu items used to enable or lock out (hide) other menu items. Loc menu items may in turn
be locked out by a hardware jumper. Please see Section 9.
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| 16. DUAL OR QUAD RELAY OUTPUT OPTION I

An optional relay board may be installed in the

meter main board at plug position P2, adjacent to

the power supply board. Four board versions are

available: 2 or 4 relays, mechanical or solid state.

Once installed, the relay board is recognized by

the meter software or PC-based Instrument Setup

software, which will bring up the appropriate menu

items for the type of board. These menu items will

not be brought up if no relay board is detected.

Menu selections for relays 3 and 4 will not be

brought up if the dual relay board is detected. All relay boards offer a choice of operating
modes: normally off or on, latched or non-latched, hysteresis band, deviation band, alarm
based on the filtered or unfiltered signal, and selectable number of readings in alarm zone to
cause an alarm.

KEYSTROKES FOR VIEWING & CHANGING SETPOINTS

The < (Alarms) key can be used to step through and view setpoints while the meter continues
to make conversions and performs setpoint control. If the > (Peak) key is pressed while a
setpoint is displayed, conversion stops and the setpoint can be changed. After pressing <, you
have 30 seconds, or the meter reverts to the normal display. To view setpoints, menu item
Loc3, digit 2, must have been set to 0. To change setpoints, menu item Loc2, digit 2, must
have been set to 0.

Press Digit
Alarms Key Select Key Eress Value Select
ey
300.24 200.00 295 00

Press < (Alarms)
to display Alarm 1

Current setpoint 1 value blinks, and
Alarm 1 LED indicator lights. Press >

To change setpoint 1 value,
press A to change selected

setpoint to select a digit, which will blink. blinking digits.
395.00 395.00 305.00

Press < (Alarms)
to display Alarm 2

Current setpoint 2 value blinks, and
Alarm 2 LED indicator lights. Press >

To change setpoint 2 value,
press A to change selected

setpoint to select a digit, which will blink. blinking digits.
395.00 395.00 305.00

Press < (Alarms)
to display Alarm 3

Current setpoint 3 value blinks, and
Alarm 3 LED indicator lights. Press >

To change setpoint 3 value,
press A to change selected

setpoint to select a digit, which will blink. blinking digits.
395.00 395.00 305.00

Press < (Alarms)
to display Alarm 4
setpoint.

Current setpoint 4 value blinks, and
Alarm 4 LED indicator lights. Press >
to select a digit, which will blink.

To change setpoint 4 value,
press A to change selected
blinking digits.

gl Press < (Alarms) again. Meter will reset and display current reading.
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KEYSTROKES FOR SETPOINT SETUP
If the MENU key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

Press Menu Press Digit
Select Key Select Key Eress VElle SEEe
ey
B Relay1on Relay 2 on
Alarm Setup for Relay state when Relay 1 off Relay 2 on
relays 1 & 2 if alarm is active. Relay 1 on Relay 2 off
detected. Relay 1 off Relay 2 off
Press > until ALSEt B Alarm 1 auto reset Alarm 2 auto reset
is displayed. Alarm latching or non- Alarm 1 latching Alarm 2 auto reset
latching (auto reset). Alarm 1 auto reset Alarm 2 latching
Alarm 1 latching Alarm 2 latching
B AL1 active high AL2 active high
Alarm operates at and AL1 active low AL2 active high
above setpoint (active AL1 disabled AL2 active high
high) or at and below AL1 active high AL2 active low
setpoint (active low). AL1 active low AL2 active low
AL1 disabled AL2 active low
B AL1 active high AL2 disabled
AL1 active low AL2 disabled
B AL1 disabled AL2 disabled
B AL1 band deviation AL2 band deviation
Hysteresis mode or AL1 split hysteresis AL2 band deviation
band deviation mode AL1 band deviation ALZ2 split hysteresis
AL1 split hysteresis AL2 split hysteresis
No deviation or hysteresis in menu.
AL1 span hysteresis AL2 band deviation
B AL1 span hysteresis AL2 split hysteresis
AL1 span hysteresis AL2 span hysteresis
B After 1 reading After 16 readings
Number of consecutive After 2 readings After 32 readings
readings in alarm zone After 4 readings B After 64 readings
to cause an alarm. After 8 readings After 128 reading
B Relay 3on Relay 4 on
Alarm Setup for Relay state when Relay 3 off Relay 4 on
relays 3 & 4 if alarm is active. Relay 3 on Relay 4 off
detected. Relay 3 off Relay 4 off
Bl Alarm 3 auto reset Alarm 4 auto reset
Alarm latching or non- Alarm 3 latching Alarm 4 auto reset
latching (auto reset). Alarm 3 auto reset Alarm 4 latching
Alarm 3 latching Alarm 4 latching
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Press Menu Press Digit Press Value Select
Select Key Select Key Key
B AL3 active high AL4 active high
Alarm Setup for Alarm operates at and AL3 active low AL4 active high
relays 3 & 4 above setpoint (active AL3 disabled AL4 active high
(continued) high) or at and below AL3 active high AL4 active low
setpoint (active low). AL3 active low AL4 active low
AL3 disabled AL4 active low
B AL3 active high AL4 disabled
AL3 active low AL4 disabled
B AL3 disabled AL4 disabled
] AL3 band deviation AL4 band deviation
Hysteresis mode or AL3 hysteresis AL4 band deviation
band deviation mode AL3 band deviation AL4 hysteresis
(see Glossary) AL3 hysteresis AL4 hysteresis
B} After 1 reading After 16 readings
Number of consecutive After 2 readings After 32 readings
readings in alarm zone After 4 readings B After 64 readings
to cause an alarm. After 8 readings After 128 reading
Select ¥ thru ] for flashing first digit, [§] thru §
Alarm 1 0.0000 for other flashing digits. Alarms will activate
hysteresis Select digit to flash. above the setpoint by the value entered and
deactivate below the setpoint by the value
DEUZ2H
entered.
Alarm 2
hysteresis
DEU1b BN | Select K thru § for flashing first digit, [§ thru g
Alarm 1 band for other flashing digits. Alarms will activate
deviation Select digit to flash. above and below the setpoint by the value
entered and will deactivate in the middle of
DEU2b the band.
Alarm 2 band
deviation
BRI | Select K thru ] for flashing first digit, [§ thru
Alarm 3 0.0000 for other flashing digits. Alarms will activate
hysteresis Select digit to flash. above the setpoint by the value entered and
deactivate below the setpoint by the value
DEU4H
entered.
Alarm 4
hysteresis
DEU3b PXOLLl) ONOLElele PHlel) | Select X thru ] for flashing first digit, [§] thru §
Alarm 3 band for other flashing digits. Alarms will activate
deviation Select digit to flash. above and below the setpoint by the value
entered and will deactivate in the middle of
the band.
Alarm 4 band
deviation
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| 17. ANALOG OUTPUT OPTION I

An optional analog board may be installed in the meter at rear panel jack position J4, adjacent
to the signal conditioner board. Once installed, this board is recognized by the meter, which
will bring up the appropriate menu items for it. These will not be brought up if an analog output
board is not installed.

The analog output can be a 0-20 mA, 4-20 mA or 0-10V unipolar signal with respect to isolated
ground, or a bipolar -10V to +10V voltage signal with respect to a reference return line.
Unipolar or bipolar operation is selected by a jumper. A unipolar current or voltage output is
selected at the connector. Unipolar 4-20 mA or 0-20 mA current is selected in software.

Unipolar current of voltage: Jumper a
Bipolar -10 to +10 voltage: Jumper b

The low analog output (0 mA, 4 mA, 0V, or -10V) may be set to correspond to any low
displayed reading An Lo . The high analog output (20 mA, OV or 10V) may be set to corres-
pond to any high displayed reading An Hi. The meter will then apply a straight line fit between
these two end points to provide an analog output scaled to the meter reading.

KEYSTROKES FOR SETUP
If the MENU key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

Press Menu Press Digit Select Press Value Select

Select Key Key Key
[ 00 ] 0-20 mA current output
Analog Output Setup. | Analog output signal 0-10V voltage output
Press > until AnSEtis | selection. 4-20 mA current output
displayed (requires -10 to +10V voltage output
analog output board). )

goup ) [ 00 @ Analog output unfiltered

Analog output filtering. Analog output filtered

Low displayed value
for 0 mA, 4 mA, 0V, or
-10V output

.0000g0.00000.0000

.0000@0.0000

Select digit to flash.

ii

Select X thru ] for flashing first
digit, § thru ] for other flashing

digits. Decimal point location is
fixed by selection.

High displayed value
for 20 mA or 10V out-
put

.0000g0.00000.0000

.0000m0.0000

Select digit to flash.

ii

Select X thru ] for flashing first
digit, § thru ] for other flashing

digits. Decimal point location is
fixed by selection.
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| 18. SERIAL COMMUNICATION OPTIONS I

A serial communications board  may be connected to the meter main board at plug position
P13 (middle position). Available boards are RS232, RS485 (with dual RJ11 connectors),
RS485 Modbus (with dual RJ45 connectors), USB, USB-t0-RS485 converter, Ethernet, and
Ethernet-to-RS485 converter. The dual connectors of RS485 boards are wired in parallel to
allow daisy chaining of addressable meters without use of a hub. Three serial communication
protocols are selectable for all serial boards: Custom ASCII, Modbus RTU, and Modbus ASCII.

A USB-t0-RS485 converter board or an Ethernet-to-RS485 converter board allows a meter
to be interfaced to a computer and be the device server for a network of up to 31 other meters
on an RS485 bus, while itself retaining all capabilities of a meter. The remote meters need to
be equipped with our RS485 digital interface board with dual 6-pin RJ11 jacks, not our RS485
digital interface with dual 8-pin RJ45 jacks. The dual 6-pin RJ11 jacks on the RS485 board are
wired in parallel to allow multiple meters to be daisy-chained using readily-available 6-wire
data cables with no need for hand-wiring or an RS485 hub. The outer two wires are used for
ground.

Use 6-wire, straight-through data cables, not 4-wire telephone cables or crossover cables,
all the way from the device server to the last device on the RS485 bus. Connect ATX to ATX,
BTX to BTX, etc., with no crossover as you go from device to device.

To connect a meter with a USB board to a computer, use a USB cable with Type A and
Type B connectors. The computer will display “Found new Hardware” followed by “Welcome to
the Found new Hardware Wizard.” Follow the instructions for software installation from a CD.
When the installation is complete, use Device Manager to determine the com port. To get to
Device Manger, go to the Windows Control Panel, click on System, click on the Hardware tab,
then click on Device Manager. Go down the device list and click on Ports (COM & LPT) and
USB serial port (com #). Note the com port # for use with communications to your meter, then
exit Control Panel. If you later need to change the Com port, right-click on USB serial port
(com #), then on Properties, Port settings, and Advanced. Change port to the desired number,
click OK, then exit Control Panel.

To connect a meter with an Ethernet board to a comp  uter, see our separate Ethernet
Manual, which covers our Node Manager Software. This Windows-based application runs on a
host computer and is used to configure our Ethernet Nodes. It automatically discovers all
Nodes on a LAN or WAN, plus any devices connected to Server Nodes via an RS485 bus. It is
used to configure each Node, such as setting communication parameters, naming the Node
and associated devices, entering email addresses for alarm notification and data requests,
selecting the Node's time zone for time-stamping of emails and streaming data, and upgrading
firmware. Once configuration data has been stored in flash memory of all Nodes, Node
Manager Software can be closed.

BOARD SETUP VIA JUMPERS

USB Board
No jumpers required.
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Basic Ethernet Board
No jumpers needed.

RS232 Board

e - Normal operation.
f - Slave display to RS232 from another meter.
g - Pull-up resistor on RTS line.

Note: Board is shipped with jumpers e and g installed

RS485 Board, Full Duplex Operation

b & d - Installed on last meter in long cable run.
RS485 Board, Half Duplex Operation

a & ¢ - Installed for half duplex operation.
d - Installed on last meter in line with long cable runs.

Note: Board is shipped with no jumpers installed.

RS485-Modbus Board, Full Duplex Operation

b & e - Bias jumpers should be installed on 1 board.
a & d - Installed on last meter in long cable run.

RS485-Modbus Board, Half Duplex Operation

b & e - bias jumpers installed on 1 board.
c & f - installed for half duplex operation.
a - installed on last meter in line with long cable runs.

Note: Board is shipped with no jumpers installed.

Modbus

Ethernet-to-RS485 Converter Board
& USB-t0-RS485 Converter Board

Full Duplex Operation

No jumpers for short cable runs.
Add b & d for long cable runs.

Half Duplex Operation

a & ¢ - Installed for half duplex operation.
d - Installed on last meter in line with long cable runs.
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SERIAL CONNECTION EXAMPLES
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KEYSTROKES FOR SETUP
If the MENU B= key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

Press Menu Press Digit Select Press Value Select
Select Key Key Key

| 000 B Send unfiltered signal

Fixed Parameters: | Output filtering Send filtered signal

No parity

8 data bits __000 8 300 baud

1 stop bit Baud rate 600 baud
1200 baud
2400 baud
4800 baud
9600 baud
B 19200 baud

| 000 60 Hz 50 Hz
Output update rate @ Line frequency Line frequency

0.28 sec 0.34 sec
0.57 sec 0.68 sec
1.1 sec 1.4 sec
2.3 sec 2.7 sec
4.5 sec 5.4 sec
B 9.1sec 10.9 sec
18.1 sec 21.8 sec
[ 36.6 sec 43.5 sec
B 72.5sec 97 sec
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Press Menu

Press Digit Select

Press Value Select

Select Key Key Key
0000 [l No line feed after carriage return
Serial Setup 2 Line feed Line feed after carriage return
0000 @ No alarm data
Alarm data with readings Alarm data with reading
0000 @ Continuous data output
Control of data output Data output on ASCII command only
0000 Select fl thru [g for addresses 1 thru 15.
Meter address with Custom | Select [0} thru [g@ (with decimal point) for
ASCII protocol addresses 16 thru 31.
00000 B Full duplex
Serial Setup 3 Half or full duplex Half duplex
00000 @ Standard continuous mode
Special start & stop char. Special start & stop characters
00000 @ Normal RTS
RTS mode Single transmission
00000 @ Only at end of all items
Termination characters At end of each item
00000 B Reading
Serial Setup 3 Data sent in continuous Peak
(continued) mode Valley
Reading + peak
Reading + valley
Reading + peak + valley
SEr 4 | 000 M 1sec
Serial Setup 4. Modbus ASCII gap timeout 3 sec
5 sec
10 sec
| 000 B Custom ASCII
Serial protocol Modbus RTU
Modbus ASCII
| 000 B None, 2 or more stop bits
Parity Odd, 1 or more stop bits
Even, 1 or more stop bits
__000M 000 000
Modbus Address. Select digit to flash. Select [§ through B for flashing digit.

Appears only if the
Modbus protocol is
selected.

Address range is 1 to 247.
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| 19. EXCITATION OUTPUT & POWER SUPPLY I

Three isolated transducer excitation output levels are available from the power supply board.
These are selectable via jumpers b, c, d, e, f in the upper right of the board, as illustrated.
In addition, the board provides three jumper positions for special features. The same jumper
locations apply to the universal power supply (85-264 Vac) and to the low voltage power
supply (12-32 Vac or 10-48 Vdc).

Excitation output Jumper locations
5 Vdc +5%, 100 mA max b,d, e
10 Vdc £5%, 120 mA max b, d,f
24 Vdc 5%, 50 mA max c

SELECTION OF OTHER JUMPERS

Jumper a - Front panel menu lockout, locked when installed. (See Section 9)
Jumper g - Provides +5V power output at P1-4 when installed.
Jumper h - Connects "Control Input 2" to P1-4 when installed.
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| 20. INSTRUMENT SETUP VIA PC I

Instrument Setup software is a PC program which is much easier to learn than front panel
programming. It is of benefit whether or not the meter is connected to a PC. With the meter
connected to a PC, it allows uploading, editing and downloading of setup data, execution of
commands under computer control, listing, plotting and graphing of data, and computer
prompted calibration. With the meter unconnected to a PC, it provides quick selection of
jumper locations and a printable display of menu selections for front panel setup.

SOFTWARE INSTALLATION

Download IS2*.exe onto your PC from the web or the distribution CD. Double-click on the
downloaded file to unzip it into a special directory, such as c:\temp. Within that directory,
double-click on setup.exe, which will install the software on your PC.

PREREQUISITES FOR CONNECTED USE

1) PC with available RS232 com port.

2) Meter to be set up.

3) RS232 board in the meter. This board can be
used for meter setup, then be removed.

4) RJ11-to-DB9 RS232 cable to connect the meter
and PC (see Section 1, Ordering Guide).

5) Instrument Setup software.

ESTABLISHING COMMUNICATIONS

Connect the meter and PC. Apply power to the meter. Be sure that the meter is in Run
Mode, not Setup Mode. To start the software from Windows, click on Start => Programs =>
IS2 => IS2. Click on RS232 => Establish. The program will temporarily set the selected Com
port to the required baud rate, parity, data bits and stop bit. Once communications have
been established, click on Main Menu. The software will sense the type of meter and
installed boards, but it cannot sense jumpers positions nor set jumpers for you. If the
computer is not connected to a meter, select DPM and Series 2.
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SETUP OF CONNECTED METER

A setup file can be retrieved from the meter (DPM => Get Setup), be edited (View =>
Setup), be saved to disk (File => Save Setup), be retrieved from disk (File => Open Setup),
and be downloaded into one or multiple meters (DPM => Put Setup). Downloading of setup
files from a PC can be a major time saving when multiple meters have to be set up in the
same way.

You will find that Instrument Setup software is very user friendly, with separate tab-
selectable windows for Input+Display, Scaling, Filter, Relay Alarms, Communications,
Analog Out, and Lockouts. If the required hardware, such as the analog output board, is not
sensed, the corresponding tab will be grayed out.

ADDITIONAL FEATURES

The Commands pull-down menu allows you to execute certain meter functions by using
your computer mouse. You can reset individual meter functions, display current or peak
readings, and enter numbers to be displayed remotely by the DPM. The first position of a
transmitted number must be a blank, + sign or - sign. Five digits and a decimal point must
be transmitted. Leading O’s serve as blanks. The Commands pull-down menu will be grayed
out unless a Get Setup has been executed.

Plot Graph
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- The Readings pull-down menu provides three formats to display DPM data on the PC
monitor. Use the Pause and Continue buttons to control the timing of data collection, then
press Print for a hardcopy using your PC printer.

- List presents the latest readings in a 20-row by 10-column table. Press Pause at any
time to freeze the display. Press Print for a hardcopy. List can capture peak readings.

- Plot generates a plot of readings vs. time in seconds. It effectively turns the DPM-PC
combination into a printing digital oscilloscope.

- Graph generates a histogram, where the horizontal axis is the reading and the vertical
axis is the number of occurrences of readings. The display continually resizes itself as
the number of readings increases.

The Jumpers pull-down menu provides
jumper positions for the various meter boards,
duplicating information in this manual.

The Calibration pull-down menu allows
easy calibration of voltage and current ranges
for the DC, load cell, and AC RMS signal
conditioner boards. The PC first recognizes
the type of board, then prompts you to apply
specific jumpers and calibration signals. Press
Ready to take a reading. Press Repeat to take
more readings. When you have decided on
which reading to accept, press on the number
1 through 10 of that reading. Additional cali-
bration software is available online.

METER SETUP WITH AN UNCONNECTED PC

Instrument Setup software is also of benefit when the
PC is not connected to a meter. Upon launching the
software, click on None for Communications, then on
DPM and Series 2. Click on File => Default Setup to
retrieve a default setup file from disk, or on File => Open
Setup to retrieve a previously saved setup file from disk.

To enter new setup information, click on View => Setup,

then make your screen selections as if you were

connected to a meter. Tabs will be grayed out if you

have not selected the required hardware under the

Input+Display tab. When done, press on Main Menu,

then on View => Menu. The selections made under

Setup will now be shown in the form of the required front

panel programming sequence, where each row corresponds to a menu item selected by the
> key, and the seven data columns correspond to values entered via the > and A keys.

Click on any step in the sequence to bring up a detailed help window.

Click on Print for a hardcopy, which you can then use as an instruction sheet to program
your meter via its front panel.

Click on Main Menu => File => Save Setup As to save your setup to disk and have an
electronic record.
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| 21. CUSTOM CURVE LINEARIZATION I

Curve.exe is a DOS-based, executable PC program used to set up an Extended meter so that
the readings have a user-defined, non-linear relationship with the input signal. The calculated
linearizing parameters are downloaded into non-volatile memory of the meter. For example, it
allows a meter to correct for transducer nonlinearity or to display volume of an irregularly
shaped tank based on liquid level. The curve-

fitting algorithm uses quadratic segments of

varying length and curvature, and provides

diagnostics to estimate curve fitting errors.

The program is self-prompting, avoiding the

need for a detailed printed manual. This

manual section is only intended as an intro-

duction and get-started guide.

PREREQUISITES

1) PC-compatible computer with an available Com 1 or Com 2 RS232 port.
2) Extended meter.

3) An RS232 board in the meter. This board can be
used for meter setup only, then be removed.

4) An RJ11-to-DB9 RS232 cable to connect the
meter and PC (see Section 1, Ordering Guide).

5) Curve.exe software (downloadable from the web
at no charge).

GETTING STARTED

Download curve.exe into the same directory that will contain your data files, such as
c:\curves. Set the meter baud rate to 9600. To do so, press the > key to get to SJ=2g, then
set the entry to [Jl§E8. Set the meter address to 1. To do so, press the > key to get to
B, then set the entry to [JS0}Bl. To execute the program from Windows, simply double-click
on curve.exe, which is an executable file. Follow the steps on computer screens, which will
prompt you and provide extensive information. Pressing R (Enter) returns to the main menu.

You will be given the choice to enter your data in one of four modes:

1) Text file entry mode, with an X value in one column and a Y value in another. There
can be additional columns, which are ignored. The file must have a DOS name of up to
8 characters and the extension .RAW. There can be from 5 to 180 rows. X is the input
value and should be in the unit of measure for which the meter was set up, such as mv,
V, mA or A. Y is the desired corresponding reading and can range from -99999 to
99999 with any decimal point.

2) 2-coordinate keyboard entry mode, where an actual X input signal is applied, and the
desired Y reading is entered from the keyboard.

3) 2-coordinate file entry mode, where an actual X input signal is applied, and the
desired Y reading is provided from a file.
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4) Equation entry mode, where the coefficients of a polynomial Y = K1X"P1 + K2X"P2 +
K3*X"P3 + ... are entered. Up to 20 terms are allowed. An offset can be built into X.

You will be asked if your DPM has a revision of DPMA4L or later. You will normally select 2
(yes), since revision DPMA4L started to ship in August 2000.

You will be asked to supply the following:

LOW X-COORDINATE VALUE >
LOW INPUT MEASUREMENT VALUE >
HIGH X-COORDINATE VALUE >
HIGH INPUT MEASUREMENT VALUE >

This informs the computer of your signal conditioner jumper settings. Enter O and O for
the two LOW values. For HIGH X, enter your signal conditioner jumper range in the
same units of measure that you will be using in your *.RAW data input file. Enter 20 for
20 mV or 20V. Enter 200 for 200 mV or 200V. Enter 5 for 5A AC or DC. For HIGH
INPUT MEASUREMENT VALUE, enter 20000, except for 5A DC, where you should
enter 5000.

Position of the decimal point from 6=X.XXXXX, 5= XX. XXX, 4=XXX.XXX, 3=XXXX.XX,
2=XXXXX. X, 1=XXXXXX (for DPMs, the leading X is a blank). Specify the same position
that you specified in the decimal point menu selection.

Follow the steps on the screens to finish generating the custom curve. When prompted to
download the file to the meter, select Y. When prompted to set the meter to custom curve
mode, also select Y.

KEYPAD CONTROL

You can take a meter in and out of custom curve linearization using the meter keypad.
From the Menu mode, press the > key to get to [)lm€], then set the fifth digit to either [§
(normal linear operation) or to M (custom curve operation). This fifth digit will only be
displayed with an Extended meter.

FILES USED OR CREATED BY CURVE.EXE
1) *RAW is the raw input file generated by all four data entry methods.

2) *.DVD adds three columns from which the smoothness of the input data and obvious
input errors can be judged. The more data points and the smoother the data, the better
the curve fit.

3) *.NUM lists Y readings prior to custom curve linearization and addition of the decimal
point.

4) *.CCF is an internal file used by the software.
5) *.SIM lists simulated linearized meter readings and calculated corresponding errors.
6) *.PRM contains the final hex data that is downloaded into the meter.
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| 22. METER CALIBRATION I

All analog input and analog output ranges of the meter have been digitally calibrated at the
factory prior to shipment using calibration equipment certified to NIST standards. Calibration
constants are stored digitally in non-volatile memory in EEPROM on the signal conditioner
board and analog output board. As a result, these boards may be mixed and interchanged
without requiring meter recalibration. Digital calibration eliminates much of circuitry that would
be associated with analog calibration, providing superior long term accuracy and stability.

If recalibration is required, the meter may be returned to the factory or to any authorized
distributor. Easy calibration of DC, AC and load cell signal conditioner ranges is possible using
the Instrument Setup software, as described in Section 20. To allow computer aided calibra-
tion, an RS232 or RS485 interface card must be installed in the meter. This card may be
installed temporarily and be removed following calibration. Step-by-step instructions and
advanced calibration software are available from the factory.
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| 23. SPECIFICATIONS I

Meter Display

TYPE oo 5 LED, 7-segment, 14.2mm (.56") high digits & 3 LED indicators
(@] (o ] SRS Red or green
RANGE.....ooieeiie s -99999 to +99999 and -99990 to +99990
A to D Conversion
Read RaAte ......coiiiiiiiiieeee e 60/s for 60 Hz NMR, 50/s for 50 Hz NMR
Output Update RAte ........cooeiiiiiiiiieeeeeeeeee e 56/s at 60 Hz, 47/s at 50 Hz
Display Update RAte ........coooiiiiiiiiiiiiiee e 3.5/s at 60 Hz, 3/s at 50 Hz
Noise Rejection
CMV from DC t0 60 HZ......cooiiiieiiieee e Withstand 250Vac
Dielectric strength...........ccooooiiiiiiiii 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
CMR from DC t0 B0 HZ ... e e e 130 dB
NMR at 50/60 HZ.......oouviiiiiiiieiieee e 90 dB with minimum digital filtering
Control Inputs (CMOS/TTL levels, logic O = tied to digital ground, logic 1 = open)
T HOIA INPUL .. Logic 0 holds display and outputs
[ Peak or Valley iNput ........cooooiiiiiiiiiiiii e Logic O displays peak/valley value
[ TAr€ INPUL ... e Logic O offsets input value to zero
[ TAre RESEL...uuiiiii e Logic O resets Tare value to zero
T RESELINPUL ... e Logic O resets all meter functions
[ Function ReSet iNPUL ........coooveiiiiiiiiiiiiee e Logic O resets peak values and alarms
/ Decimal Point input ..................... Overrides internal DP selections and controls DP position
[ Display Blank iNPUL.........uuii e Logic 0 shuts off the display
Power Requirements
Input Voltage rating (standard)......... 85-264 Vac or 90-300 Vdc (DC range not UL approved)
Input Voltage rating (low voltage option) ...........coevvviiiiiiiiiiieiiiii. 12-32 Vac or 10-48 Vdc
POWET LIiNE FIrEQUENCY .....uiiiiiiieiieiiiiiie e e ettt e e e e e et e e e e e e e e eeenennes DC and 47-63 Hz
Power CoNSUMPLION, MaAX ....cooiiiiiiiiiiiie ettt e e e e e e ee st e e e e e e eeeeesennns 5 Watts

Excitation Outputs

Voltage & Current Levels (jumper selectable) ...........cccccoeeiiiiiiininnnn. 5 Vdc £5%, 100 mA max
10 Vdc +5%, 120 mA max
24 Vdc £ 5%, 40 mA max

EXcitation OULPUL RIPPIE ... 100 mVp max
Isolation from PoOWer and QULPULS ........uuuiiii e e e 250 Vac
Insulation dielectric strength to power and outputs..... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
ISOlation tO SIgNAl COMIMON ... e e e e e ae e 50 Vdc

Input Types, Ranges, Resolution, Error at 25T
54



DC Volts Thermocouple (0.1°% 1°resolution)
Range Resol. | Resistance | Error Type Range Error
200.00 mV | 10 pv 1G ] -210to 760C |.01% FS +£0.09C
2.0000V | 100 pv 1G 0.01% -347to0 1400F |.01% FS £0.16F
20000V Imv ) 10M of S -244 10 1372C |.01% FS £0.10C
200.00 vV 10 mV 10 M +2 cts K
0 to 400C .01% FS +0.03C
DC Amps . -257t0 0C  |.01% FS +0.20C
Range Resol. |Resistance| Error 32 to 752F .01% FS +0.05F
-430to 32F |.01% FS +0.36F
2.0000mA | 0.1 pA 100 0.01%
20.000mA | 1pA 10 2270 £ -240 to 1000C |.01% FS +0.18T
200.00 mA | 10 pA 1 of FS -400 to 1830F |.01% FS +0.32F
5000A | 1mA | 001 *2.cts
' ' N -245 t0 1300C |.01% FS +£0.10C
-410 to 2370F |.01% FS +£0.17F
True RMS Volts (0% to 100% of Full Scale,
0 Hz and 10 Hz to 10 kHz, crest factor 3.0) S -46 t0 +1768T |.01% FS +0.12C
-51 to +3213F |.01% FS +£0.22F
Range Resol. [ Resistance | Error
R -451t0 1768C |.01% FS £0.17<C
200.00 mV | 10 pv 22 M -49 to 3214F |.01% FS +0.31F
2.0000V | 100 pv 22 M 0.1%
20.000 V 1 mVv 1M of FS | RTD (0.01° 0.1° 1°resolution)
200.00 V 10 mV 1M
Type Range Error
600.0 V 100 mV 1M 2V
Pt 100 -202 to 850C |[.01% FS +0.03C
True RMS Amps (0% to 100% of Full Scale, | .00385 | -331to 1562% |.01% FS +0.05F
0 Hz and 10 Hz to 10 kHz, crest factor 3.0) Pt 100 2202 10 631C | 01% FS +0.04C
Range Resol. |Resistance | Error .003925 | -331t0 1168F |.01% FS +0.07F
2.0000mA | 0.1 pA 100 0.1% Ni 120 -80 t0 260C |.01% FS +0.05C
20.000 mA 1 pA 10 : .00672 | -112to 500F |.01% FS +0.09F
200.00 mA | 10 pA 1 of FS
: a Cu 10 -97 t0 260C |.01% FS +0.05C
5.000 A 1 mA 0.01 20 mA .00427 | -143t0o 500F |.01% FS +0.09F
Resistance Measurement Ratio, Potentiometer Follower, Strain
Range Resolution Error Range Resol. [Resistance| Error
0-20.000 1m 200.00 mVv 10 pv 1G 0.01%
0-200.00 10 m 0.01% 2.0000 V 100 pv 1G of FS
0-2000.0 100 m of FS 20.000 V 1mVv 1M 12 cts
0-20000 1 12 cts
0-200.00 k 10

Load Cell Input
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Range Resolution Resistance | Zero Range | Span Range Error

20.000 mVv 1pv

50.000 mV 2.5 uv ) 0

100.00 mV 5 LV 1G 9§§§§9t° 0 to £99,999 O'O}rz/"cct’; FS

250.00 mV 12.5 pv B

500.00 mV 25 uv

Thermocouple Accuracy
SPAN TEIMPCO ...ttt e e e e e e e e e et e e e e eaaaeeeas 0.003% of reading/T
0.0015% of reading/< for load cell meter
WA =T (o I =T ] oo o ISP 0.2 pv/IT
Reference JUNCHON ACCUIACY ......c.uuuuuiiiieeeeieieiiiiiiaa e e e e e e eeeeiiiaae e e e e e e eeeennnnns 1C, 10Ct 040C
Dual & Quad Relay Options

Power to Relay OPtioN .......coooo oot eeeaaaees Powered by meter
Setpoint SETUP.....evvveiieie e Via front panel pushbuttons or RS232/485
UPate RALE ... .o 56/s at 60 Hz, 47/s at 50 Hz
Response to input signal (IMiN) ..........oiiii e Display update rate
Input Signal (selectable) ... Filtered or unfiltered input signal
Actuation Modes (selectable)...... Above or below setpoint, latching or non-latching, disabled
Output Time Delay (Selectable) ... 1 to 128 readings
Front Panel Enable / Lockout Modes (selectable)................ 1) Display and change setpoints

2) Display but do not change setpoints
3) Neither display nor change setpoints

Alarm Status INAICAION ........coooiiiiiiiiiii e 2 or 4 red LED lamps
Status Indication Setup (selectable)....................... Lit when output is ON or OFF, or disabled
Form C, SPDT Relay Output:

Y O - 11| o USSP 8A @ 240 Vac
[T @ = 1 T PSPPSR 8A @ 24 Vdc
Isolation rating between signal common and CONtaCtS .............eeiiieeieiiiiieiiiiiiiieee e, 250 Vac
Insulation dielectric strength between signal common and contacts ............cccoeeeeeeiiiiiiiiiiinnnn.
................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
Form A, SPST Solid State Relay Output:

Y O - 11| o PP 130 mA @ 140 Vac
L@ = 1 Vo SRR 130 mA @ 180 Vdc
Isolation rating between signal common and CONtaCtS .............eeiiinieeiiiiiiiiiiiiiiee e, 250V ac
Insulation dielectric strength between signal common and contacts ............cccoeeeeeeiiiiiiiiiinnnn.
................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min

Analog Output Option

Power to Analog OULPUL OPLION........uuuiiiieeeeieieiiiieee et eeeeeaees Powered by meter
OULPUL LEVEIS ... 0-20 mA, 4-20 mA, 0-10V, -10 to +10V
Voltage Compliance, 0-20 MA OULPUL .......cooeiiiiiiiiiiiiiiee e 12V (0-600 Ohm load)
Current Compliance, 0-10V, -10 to +10V Output.............eeuunnn... 2 mA (5 kOhm or higher load)
ACCUIACY ..cevvviiiieeeeeeeeeeeiiiia e Meter input accuracy £0.02% of full scale analog output
RESOIULION . 16 bit (1 part in 65,536)
RESPONSE TIME ...t e e e e eeanene 50/60Hz update rate



Scaling of Reading for Zero OULPUL...........uuuiiiiiiiiiiiiiiiee e -99,999 to +99,999

Scaling of Reading for Full Scale OutpUL...........ccooviiiiiiiiiiii e -99,999 to +99,999
Isolation rating between signal common and analog OULPUL..........cccoevvviiiiiiiiiieeeeeeeee. 250V ac
Insulation dielectric strength between signal common and analog output.............cccccevvvvennnnnn..
................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
Serial Interface Option (USB, RS232, RS485, RS485-Modbus boards)
OULPUL TYPBS et RS232, RS485, RS485-Modbus, USB
.......................................... USB-t0o-RS485 converter, Ethernet, Ethernet-to-RS485 converter
Power to INterface OPtiON.......coooiiiiiiiiiie e eeeaeaees Powered by meter
RSA8BE WIING ..ottt e e e e e e et e e e e e e e eeeeennnnes Half or full duplex
Baud RatesS..........uuvvviiiiiiiiiiiiiiiiiiiiieeeeeeeeeeeeeeeeeeeeeee 300, 600, 1200, 2400, 4800, 9600, 19200
Serial Protocols..........ccccceeeeeeennnnn. Custom ASCII, Modbus RTU, Modbus ASCII (selectable)
Signal Levels........oooiiiiiiiiiiiiii e, Meet RS232, RS485, USB, Ethernet standards
Isolation rating between signal common and serial /O ............ccoiiiiiiiiiiiiiiiiiii e 250V ac
Insulation dielectric strength between signal common and serial /O ..........cccooveiiiiiiiiiiiiiennnn.
................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
Option Board Connectors:
R S 232 e Single RJ11 jack
RSA485 ..., Two RJ11 jacks (for daisy chaining with 6-wire data cables)
RS485 Modbus.............euenne... Two RJ45 jacks (for daisy chaining with 8-wire data cables)
(010 = PP USB type B plug
USB-t0-RS485 converter..........ccccceeeeeeennnnn. USB type B plug plus RJ11 jack to RS485 bus
EINEINEL..... e Single RJ45 to Ethernet
Ethernet-to-RS485 converter.............. RJ45 jack to Ethernet plus RJ11 jack to RS485 bus
Environmental
Operating TEeMPEIATUIE ........ouuieiiee ettt e ettt e e e e e e e eeaat e e e e eeaeeeennenes 0C to 55T
StOrage TEMPEIALUIE ........ueeiii e e e e e e e e e e e enn e -40C to 85T
Relative HUMIdIty ..........eoiiiiiiiiiiii e 95% from 0T to 40C, non-condens ing
Case....coiiiiiiii e NEMA-4X (IP65) from front when panel mounted (not verified for UL)
SNOCK e 10 G at 1 kHz, applied in X, Y, Z axes
Vibration ........oouiiiiiiie 15 Hz to 150 Hz, 1 mm to 2 mm amplitude, 20 G max.
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| 24. GLOSSARY OF TERMS I

Adaptive Filter Threshold

A threshold which causes an adaptive moving average filter to be reset to the
latest reading when the accumulated difference between individual readings
and the filtered reading exceeds that threshold. Adaptive moving average
filtering allows a meter to respond rapidly to actual changes in signal while
filtering out normal noise. The accumulated difference is also reset to zero
when the latest reading has a different polarity than the filtered reading. A low
adaptive filter threshold is normally selected. A high filter threshold should be
selected if the signal has large transients.

Alarm, Latched
An alarm which stays actuated until reset.
Latched alarms can shut down machinery or
a process when an operating limit has been
exceeded, or maintain an alarm condition
until acknowledged by an operator.

Alarm, Non-latched
An alarm which changes state automatically
when the reading rises above a specified limit
and changes back automatically when the
reading falls below a limit.

Autofilter A selectable digital filter mode which auto-
matically selects an appropriate moving aver-
age filter time constant from 0.08 sec to 9.6
sec for the encountered noise condition.

Auto-tare A selectable meter operating mode, where
the first reading following power-on or meter reset is used to zero the display.
Further readings are then relative to this new zero.

Batch Average Filter

A digital filter mode which averages 16 readings and then displays the average.
Readings are taken at 60/sec with 60 Hz power and 50/sec with 50 Hz power.

Counts The reading displayed on the panel meter ignoring the decimal point.

Custom ASCII Protocol
A simplified, short protocol for use with these panel meters. It allows 31 digital
addresses. Not an industry-standard protocol, like the more complex Modbus
protocol, which is also offered with the meters.

Deviation Band
A band in counts which controls relay action symmetrically around a setpoint.
The relay actuates when the reading falls within the deviation band, and de-
actuates when the reading falls outside. A limit (e.g., 50 counts) is set up
around both sides of the setpoint to create a deviation band (e.g., 100 counts).
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Setting up a passband around a setpoint is
often used for component testing. Deviation
limits are programmed by entering menu item
dEU1b for Alarm 1 and dEU2b for Alarm 2.
The deviation band will be equal to two limits.

Display Blank A rear panel input which blanks the display

when the input is tied to logic ground by a
switch or OV is applied (logic level true). The
meter display will light when the input is
open or is held at +5V (logic level false).

Extended Meter

Full Scale

A digital panel meter with an enhanced microcomputer that provides added
capabilities, specifically linearization of nonlinear inputs and display of rate of
change from successive readings.

The maximum input signal range for which the meter has been configured. For
example, the most sensitive full scale for the load cell meter is £20 mV (signal
range from -20 mV to +20 mV).

Function Reset

Ground Loop

Jumper

A rear panel control input which resets Peak, Valley and any latched alarms
when the input is tied to logic ground by a switch or OV is applied (logic level
true). To reset the value again, the input must be open or 5V applied (logic
level false) and then set low.

A closed conductive path in external ground wiring that allows stray currents to
flow in ground wiring, creating ground noise. The meters in this manual
minimize ground loop problems by mutually isolating the grounds associated
with meter power, signal input, and all output and communication options.

A push-on component which provides a short between two adjacent posts on a
circuit board. Jumpers are used to configure signal conditioner boards for
specific signal types and full scale ranges, and to configure power supply and
communications boards for various modes of operation. Unused jumpers are
stored by pushing one side over an unused post.

Hysteresis Band

A band which controls relay action sym-
metrically around a setpoint. The relay
closes (or opens) when the reading goes
above the setpoint plus one hysteresis limit,
and opens (or closes) when the reading
falls below the setpoint less one hysteresis
limit. A narrow hysteresis band is often
used to minimize relay chatter around a
setpoint due to electrical noise or signal
feedback caused by load switching. A wide
hysteresis band can be used for control applications, such as turning on a fill
pump when the tank level has reached a lower limit and shutting off the pump
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Menu Mode

Meter Hold

Modbus

when the tank level has reached an upper limit. The hysteresis band will be
equal to two hysteresis limits.

The meter programming mode used for input and range selection, meter setup,
and meter configuration. Entered into from the Run mode by pressing the
MENU key. The Menu mode can be locked out completely by a jumper.

A rear panel input which freezes the meter display and all meter outputs while
that input is tied to logic ground by a switch or is held at OV (logic level true).
The meter will resume operation when the input is allowed to float or is held at
+5V (logic level false).

An industry-standard serial communications protocol which allows devices by
different manufacturers to be digitally addressed by a PC on the same com-
munication line, with up to 247 digital addresses. More complex than the
Custom ASCII protocol, which is also supported by these meters.

Moving Average Filter

Offset

Peak Display

Process Signal

A digital filter mode which displays a weighting moving average of readings.
Readings are taken at 60/sec with 60 Hz power and 50/sec with 50 Hz power.
Display update rates remain 3.5/sec with 60 Hz power and 3.0/sec with 50 Hz
power. There are eight moving average modes:

Old average x 1/2 + new reading x 1/2 (equivalent to 0.08 sec RC time constant).
Old average x 3/4 + new reading x 1/4 (equivalent to 0.15 sec RC time constant).
Old average x 7/8 + new reading x 1/8 (equivalent to 0.3 sec RC time constant).
Old average x 15/16 + new reading x 1/16 (equivalent to 0.6 sec RC time constant).
Old average x 31/32 + new reading x 1/32 (equivalent to 1.2 sec RC time constant).
Old average x 63/64 + new reading x 1/64 (equivalent to 2.4 sec RC time constant).
Old avg. x 127/128 + new reading x 1/128 (equivalent to 4.8 sec RC time constant).
Old avg. x 255/256 + new reading x 1/256 (equivalent to 9.6 sec RC time constant).

A constant adder used for the displayed reading. This is the term b in the
straight line formula y = mx + b, where y is the displayed reading in counts, m
is the scale factor, x is the measured reading in counts, and b is the offset. For
direct readout in (milli)volts or (milliyamps, offset is 0.

The maximum (or most positive) reading since that maximum was last reset.
Reset can be via the meter front panel, an external input, or a software
command. The displayed value can reflect the filtered or unfiltered readings.

A signal whose display requires setup of scale and offset settings for display in
engineering units. A classical process signal is 4-20 mA, where the 4 mA and
20 mA end points can each correspond to a desired meter reading.

Rate of Change Meter

A configuration mode of the Extended meter which allows the display of rate
based on successive readings. The conversion to engineering units is achieved
with the combination of a multiplier from 0.1 to 10,000 and a scale factor.
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Reading

The value displayed by the meter. “Taking a reading” is the action of the meter
to make an analog-to-digital conversion. Readings are taken at 60/sec with 60
Hz power or 50/sec with 50 Hz power, and are displayed with an update rate of
3.5/sec with 60 Hz power or 3.0/sec with 50 Hz power.

Remote Display

Reset

A display mode which allows the meter to serve as a remote display to another
meter when connected to it by a 4-wire phone cord. Also allows the meter to
transmit raw measurement data to a computer and then display processed data
from the computer. A serial communications option board is required in the
meter. If such a board is not installed or no serial data is received, the meter
displays rESEt.

There are three types of Reset:
Peak and Valley Reset. Achieved by simultaneously pressing the RESET
and PEAK keys.
Latched Alarm Reset. Achieved by simultaneously pressing the RESET and
ALARMS keys.
Meter Reset. Causes the meter to reinitialize and take a tare reading when
set up for auto-tare. Achieved powering up the meter, by pressing the
RESET and MENU keys simultaneously, stepping through all top-level
menu choices, grounding a rear panel connector, or supplying an ASCII
command. rESEt is displayed briefly.

RS485 Half Duplex

Serial communications implemented with two wires, allowing data transmission
in both directions, but not simultaneously.

RS485 Full Duplex

Run Mode

Scale

Scaling

Serial communications implemented with four wires, allowing data transmission
in two directions simultaneously.

The normal operating mode of the meter, where readings are taken, as
opposed to the menu mode.

A constant multiplier used to go from A/D
converter counts to displayed counts. This is
the slope term m in the straight line formula y
= mx + b, where y is the displayed reading in
counts, m is the scale factor, x is the
measured reading in counts, and b is the
offset. For direct readout in (milli)volts or
(milli)amps, scale is 1.

The process of setting scale and offset so
that the meter reads properly in engineering
units (such as psi).

Scaling, Coordinates of 2 Points Method

A scaling method where four numbers are entered manually: low input, desired
reading at low input; high input, and desired reading at high input. The meter
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then applies a straight line fit. The decimal point is set by the separate dEC.Pt
menu item.

Scaling, Scale and Offset Method

Setpoint

Span

Tare

Valley Display

Zero

A scaling method where scale and offset are entered manually. Scaling,
Reading Coordinates of 2 Points Method

A scaling method, where the low and high input values are determined from
actual signals. A known low signal is first applied to the meter, such as the
output of a pressure transducer at zero pressure. That signal is captured as the
low input value, and the desired low reading is entered. A known high signal is
then applied, such the output of a transducer for a know weight or pressure.
That signal is captured as the high input value, and the desired high reading is
entered. The meter then applies straight line fit. This scaling method has the
advantage of calibrating the transducer and meter as a system. The actual
voltage or current at either point does not need to be known. The decimal point
is set by the separate dEC.Pt menu item.

A value compared to the reading to determine the state of a relay. Term often
used interchangeably with “alarm setpoint.” The relay action can by latching or
non-latching, utilize a hysteresis band, or utilize a deviation band. Hysteresis
bands and deviation bands are specified by two symmetrical limits around the
setpoint.

The number of counts corresponding to a given signal range.

A rear panel input which causes the display to be set to zero when the input is
momentarily tied to logic ground by a switch or is held at OV (logic level true).
When the input is allowed to float or is held at +5V (logic level false), the meter
displays readings relative to this new zero. A common application is in
weighing, where an external Tare button is pressed to read the weight of an
empty scale (tare), and tare is then automatically subtracted as a constant from
gross weight for display of net weight. Tare can also be used for other appli-
cations where a reading relative to starting point is desired.

The minimum (or most negative) reading since that minimum was last reset.
Reset can be via the meter front panel, an external input, or a software
command. The displayed value can reflect the filtered or unfiltered readings.

When used with process meters, zero is an adjustment so that a given low
transducer output reads zero on the meter. Zero is adjusted by programming
offset.
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| 25. WARRANTY I

Electro-Numerics, Inc. warrants these products to be free of defects in materials and work-
manship for two years from the date of shipment to the original customer. This warranty may
be considered as unconditional provided that, in the opinion of Electro-Numerics, the
equipment has not been mechanically, environmentally, or electrically abused and has been
installed, maintained and operated within the limits of rated or normal usage. Defective
products must be sent, transportation charges prepaid, with notice of the defect, to our plant in
Temecula CA.

This warranty is limited, at the option of Electro-Numerics, Inc. to repair, replacement, or an
appropriate credit adjustment not to exceed the original equipment sales price. All warranty
freight charges are F.O.B. our plant, Temecula, CA.

Electro-Numerics assumes no responsibility in connection with the sale of its products
beyond that stated above and is not responsible for any incidental or consequential loss or
damage which might result from a failure of any Electro-Numerics, Inc. product.

| 26. REPAIR POLICY I

Direct all warranty and out-of-warranty requests/inquiries to Electro-Numerics, Inc.,
Customer Service Repair Dept., Tel: 800-854-8530 (USA) or 951-699-2437, by Fax to: 951-
695-7246 or by email to sales@electronumerics.com. Repair work will be handled at the
factory or an authorized service center. All items sent in for service are subject to a
minimum evaluation charge of $65 in the event that the product is found to be out-of-
warranty or, if under warranty, not in need of additional service. Out-of-warranty service and
repair charges will be quoted on a case-by-case basis. All repaired products will be shipped
FOB, Temecula, CA.

| 27. ELECTRO-NUMERICS, INC. PRODUCTS I

Electro-Numerics family of Digital Panel Meters and Large Digit Indicators are high quality,
accurate, solid state instruments designed for years of trouble-free operation. Over 37 years
of digital instrumentation experience has resulted in a series of displays recognized in the
field as reliable, well designed instruments. From our compact sized DPM's with 0.6" LEDs,
to our Large Digit indicators with 1" and 5" LEDs or 4", 6" and 9" tall electromagnetic digits,
we cover most applications in process measurement and display.

In addition to our digital display products, Electro-Numerics also manufactures magnetic
components including magnetic (VR) sensors, coils, transformers, ballasts and plug-in
power supplies. Please see www.electronumerics.com.
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